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WHO TO CONTACT?

Questions or problems may arise during the fielding of any software application. Therefore, a list of
contacts is provided to answer questions, receive suggestions for improvements to the software or reference

materials and/or resolve technical problems. Chapter One provides more detailed information regarding
assistance and problem reporting.

PERSONNEL PROCESS IMPROVEMENT HELP DESK

If users cannot resolve technical or functional problems with the Automated Core Document System
(COREDOC), they should contact the local Integrated Personnel Process Improvement (PPI) Suite Program
Coordinator(s). If the local Integrated PPI Suite Program Coordinator is not available, users may contact
the Air Force Personnel Center (AFPC) Software Distribution Center Help Desk. The Help Desk’s
telephone numbers are: toll free, 1-800-638-3487; commercial, (210) 652-3995/2849; and DSN, 487-
3995/2849. The fax number is (210) 652-5800.

USER’S GUIDE

Any discrepancies, errors or suggestions for improvement should be reported by the Program
Coordinator(s) to the Defense Civilian Personnel Management Service, Regionalization and Systems
Modernization, Functional Program Management Office via electronic mail or fax. If sending by e-mail, the
address is: carolyn.mcknight@cpms.osd.mil. The fax number is: (703) 696-5468.

COREDOC PROJECT MANAGER

General questions concerning the fielding and support of COREDOC may be addressed to the Project
Manager, Beres Muschett. He can be contacted by telephone on (703) 696-2666 or DSN, 426-2666, or via
fax on DSN, 426-5468 or via email beres.muschett@cpms.osd.mil.

Try CPMS World Wide Web Home Page at http://www.cpms.osd.mil/. You may contact the Project
Manager and the Help Desk from the CPMS Home Page.
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Help Desk

User’s Guide
COREDOC Project Manager

Welcome to the Core Document Development System User’s Guide.

This guide applies to the Department of Defense (DoD) Automated Core Document
Project (COREDOC) System which is an integral part of the Integrated Personnel Process
Improvement (PPI) Suite. The COREDOC software is intended to alleviate the
cumbersome process of position documentation by providing managers and personnelists
with an automated tool that will enable them to create, modify, and update such
documentation easily, quickly, and with maximum efficiency. In addition, COREDOC
provides a central source of position related data that can be used in the creation of
vacancy announcements, crediting plans, automated rating and ranking tools, and
occupational development plans. This user guide documentation was written using
Xvision. Therefore, some of the screens will appear different than those people who use
CDE Runtime. The process function remains the same.

COREDOC 1-1



Chapter One: Introduction

Purpose

The purpose of the DoD Core Document (COREDOC) Project System is to automate five
separate position related processes into an integrated single (core) document. A Core
Document contains four elements: a classified position description; performance
management plan; knowledges, skills, and abilities (KSAs) for recruitment; and basic
training competencies.

COREDOC replaces the current labor-intensive process of classifying duties and
responsibilities for position descriptions; identifying performance elements for employee
evaluation; and listing KSAs needed for recruitment and basic training competencies.
Using COREDOC, supervisors can create these documents without numerous trips to the
civilian personnel office.

The position information contained in the software was developed by teams of subject
matters experts and personnelists representing a variety of DoD agencies. COREDOC is
a menu-driven software that allows users to select major duties and responsibilities for a
position. Each major duty has related performance requirements, classification factors,
and KSAs built into the database. COREDOC automatically assigns the grade level,
factor pattern, and KSAs consistent with those duties. The result is an electronically
generated single (core) document that replaces the traditional classified position
description, performance plan, recruitment, and training criteria.

Users will note that certain menu items are “dimmed” or “grayed-out”. This indicates
that a particular function in COREDOC is still under development Additional
occupational series are currently under development and will be released upon
certification by a team of subject matter experts.

User Information

Users must be familiar with the basic operation of a personal computer (PC), a mouse,
and a printer. In contrast to traditional key-stroke based applications, the mouse is the
primary input device used to carry out most functions within COREDOC. This emphasis
on the mouse does not mean that users cannot use the keyboard, but most will find that
they interact best with the program through the mouse. Users who are not experienced
with Windows applications and use of a mouse should review Chapter Two of this Guide.

' Caution: Anyone wishing to use the keyboard should refer to Appendix D of this
guide. Appendix D contains a list of available Hot Keys. However, user should not
attempt to access the menu items in COREDOC with the keyboard.

The COREDOC user guide provides instructions on using the system and is specifically
designed for individuals who are responsible for requesting and/or approving personnel
action requests. It is also designed for personnelists who prepare personnel actions for
transmission to the Defense Civilian Personnel Data System (DCPDS).
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Chapter One: Introduction

User’s Guide Conventions

To help the user locate and interpret information easily, this guide uses various document
conventions and visual cues. These conventions include:

» Components of the PC keyboard, such as the [Enter] key, are bolded and placed in
brackets.

« &/ This checkmark is used to point out a note of additional information, such as a
tip for first-time users.

» Command Buttons are capitalized and placed in quotation marks, e.g., “CREATE,"
“EDIT”, and “EXIT.”

Security And Privacy

The information created and stored within this system is UNCLASSIFIED FOR
OFFICIAL USE ONLY. Access to COREDOC data is subject to the Privacy Act of
1974. 1t is the user’s responsibility to provide adequate computer security to protect this
information in accordance with current regulations and guidance.

Controlling Access

Normally, all individuals involved in preparing, reviewing, authorizing, or processing
position related documents will have access to COREDOC. Access is predetermined by
management and is controlled by the Username and Password combination. COREDOC
provides management with the capability of limiting any user’s access to employee,
organization, and position data. The software also allows management to establish
functional privileges for each user, such as the ability to create or edit a core document.

COREDOC has several levels of access based on whether the user is a supervisor,
manager, personnelist, or system administrator. Access does not change a manager’s
authority to request and/or authorize position related documents. Users should refer any
questions concerning individual access levels and privileges to the PPl Program
Coordinator at their local installation.

Assistance And Problem Reporting

This Guide supports the release of the COREDOC system. Since questions or problems
may arise during the fielding of any software application, this Guide provides personnel
contacts to answer questions, receive suggestions for improving the software or reference
materials, and resolve technical problems.
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Chapter One: Introduction

Help Desk

If users cannot resolve technical or functional problems with COREDOC, they should
contact their local Integrated PPI Program Coordinator. Program Coordinators will
forward the user’s request for assistance to the Help Desk.

All requests for assistance should include the following information:

Name and user identification

Component or Agency name

The type of action in process at the time the problem occurred
The exact steps taken prior to the problem’s occurrence

The exact error messages received

A thorough description of the problem.

oukrwbdE

If the local Integrated PPI Program Coordinator is not available, users may contact the Air
Force Personnel Center (AFPC) Software Distribution Center Help Desk. The Help
Desk’s telephone numbers are: toll free, 1-800-638-3487; commercial, 210-652-
3995/2849; or DSN, 487-3995/2849. The fax number is commercial 210-652-5800 or
DSN 487-5800. All problems should be submitted to the Integrated PPI Suite Program
Coordinators as soon as possible.

User’s Guide

This version of the COREDOC User’s Guide has been reviewed for clarity and functional
accuracy by functional personnel. However, users of the Guide may find discrepancies or
errors that were missed during the review process, or they may have suggestions for
improving it. Any discrepancies or suggestions for improvement should be reported by
Integrated PP1 Program Coordinator(s) to the Defense Civilian Personnel Management
Service, Regionalization and Systems Modernization Division by fax on 703-696-5468 or
DSN 426-5468 or via E-mail to carolyn.mcknight@cpms.osd.mil. All written requests or
suggestions should include the following information.

Name

Telephone number (DSN)

Component or activity name

Chapter and page number of the discrepancies, if any
Description of the suggested improvement

arwNE

COREDOC Project Manager

General questions concerning the fielding and support of COREDOC may be addressed
to the Project Manager, Beres Muschett who can be contacted by telephone at commercial
703-696-2666, or DSN, 426-2666, or via fax on DSN, 426-5468.

COREDOC 1-4



CHAPTER TWO: GETTING STARTED

Requirements 2-2

Working with Windows 2-2
Windows Tutorial

The Keyboard and COREDOC 2-3

Primary Keys Used in COREDOC

General Operations 2-3
Initiating a COREDOC Session
Exiting, Stopping or Suspending Work

This chapter contains detailed step-by-step procedures for the first time or occasional
computer user and for those users who are unfamiliar with Windows applications. It
presents sufficient detail so that users may easily access the application before learning
the details of its functional capabilities.

These sections may be disregarded if the users are familiar with the basic operation of

Windows 3.1 or Motif X-windows, personal computers (PCs), a mouse, and laser
printers.
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Chapter Two: Getting Started

Requirements

All users must be familiar with the basic operation of a PC, mouse, and printer. A 486
DX-33 PC is highly recommended with at least 8 MB RAM and a 340 MB hard drive.
Users must have an Internet Protocol address or a modem. In addition, X-Vision or CDE
Runtime is required to operate the software under a Windows 3.1 or X-windows/Motif in
a UNIX environment.

Working with Windows

This section of the Guide provides users with basic information on the use of Windows.

v Skip this section if the user is familiar with running Windows applications.

Windows Tutorial

Before proceeding, users should be familiar with the basic Windows environment. If not,
users should access the Windows Tutorial, which is an interactive, on-line program that
covers the basics of using a mouse and Windows. The Windows Tutorial Program is
accessible from the Program Manager, as the following steps illustrate.

Using the Mouse. While in the Program Manager Window, click the Help Menu and
then the Windows Tutorial command.

Using the Keyboard. Press and hold down the [Alt] key, then press the [Tab] key
repeatedly until “Program Manager” appears in the small window in the middle of the
screen. Release both keys. Press and hold down the [Alt] key, then press the [H] key.
Release both keys. Press the [Down Arrow] key to select the Windows Tutorial, then
press the [Enter] key.

v Working with multiple applications. Users should be aware that because of the
large amount of working data and complex processing of that data in COREDOC,
running other Windows applications with COREDOC is not recommended. Even while
running just COREDOC, some activities may experience a noticeable delay. During
these delays, the screen pointer appears as a watch or hourglass. The pointer returns to
normal when the process is complete.
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Chapter Two: Getting Started

The Keyboard and COREDOC

Primary Keys used in COREDOC

The following keys are common to most PCs and may be used to navigate through the
different screens within COREDOC. However, as discussed earlier in the Guide, users
will find that much of the interaction with the software is accomplished by using the
mouse.

DELETE This key deletes, removes, or eliminates any character
that appears at the cursor.

ENTER/RETURN This key moves the cursor to the beginning of the
next field or line.

SPACE BAR This key can be used to activate a highlighted button on the
bottom of a window.

TAB This key moves the cursor forward to the next
column or position on the screen.

General Operations

Initiating a COREDOC Session

To initiate a COREDOC session, go to the Windows Program Manager screen and click
the PPI icon that contains the COREDOC program. This will bring up the “Logon”
screen (Figure 3-1). After entering the assigned Username, press the [Tab] key and enter
the assigned password, press the [Enter] key or click the “CONNECT” button. After the
correct username and password combination are entered, the software displays the PPI
Application Menu (Figure 3-2). Initiating a COREDOC session is discussed further
in Chapter Three of this Guide. For users of CDE Runtime the database field must be
completed. This information is assigned at the same time the username and password are
assigned by the systems administrator.

Exiting, Stopping, or Suspending Work

To stop COREDOC from processing a particular function, click the “CANCEL” button.
Users may continue this process with each screen until they are returned to the
COREDOC Main Menu screen (Figure 3-9). Click the “File” option on the menu bar and
then select “Exit”. The software will bring users back to the “PPI Application Menu”
screen. To exit “PPI Application Menu” screen, click the “EXIT” button.
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CHAPTER THREE: COREDOC OPERATING PROCEDURES

Initiating a Session
Integrated PPI Suite Screen
CD Writer Screen

PERSACTION
PERSACTION Title Screen
In Box Screen
Page One of the Personnel Action Request

COREDOC Main Menu

File

Utility

Help
Viewing a Core Document
Printing a Core Document
Saving a Core Document as a File

System Administration Functions

3-2

3-5

3-8

3-14
3-16
3-17
3-19

This chapter describes special features within the Core Document Development System

(COREDOOC) application.
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Chapter Three: COREDOC Operating Procedures

Initiating a Session

The COREDOC application is accessed through the “PPl Application Menu." To initiate a
COREDOC session, go to the Windows Program Manager screen and click the icon that contains
the Integrated Personnel Process Improvement (PPI) Suite program. This will initiate the
“Logon” Screen shown in Figure 3-1.

Usemame:

Password:

Database:

Cunne-::tl Cancel |

Figure 3-1. Logon Screen

After entering the users’ assigned Username, press the [Tab] key to go to the “Password” block.
After entering the users assigned password, press the [Enter] key or click the “CONNECT”
command button. Click “CANCEL” to end the session. The following PP1 Application Menu

will appear after successful Logon.
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Chapter Three: COREDOC Operating Procedures

PPl APPLICATION MENU  V.5.0

| COREDOC j

: REGIONAL APPLICATION
oo rossiono [ svs oonn [ oo Jf e

DEVELOPED BY THE DEPARTHMENT OF DEFENSE
CIVILIAN PERSONHEL MANAGEMENT SERVICE

AND
THE AIR FORCE PERSOHHEL CENTER

Figure 3-2. Personnel Process Improvement (PPI) Application Screen

The application menu allows user to access PERSACTION, COREDOC, TRAIN, Regional
Application, and System Administration applications. The application menu will also allow
users to change their “UNIX” or “Oracle” password. Click “EXIT” to exit the Integrated PPI
Suite.

CD Writer

To select COREDOC, click the appropriate block with the mouse or use the [Tab] key until
COREDOC is highlighted, then press the [Enter] key. The COREDOC Program will begin.
The application will display CD Writer Cover Screen shown in Figure 3-3. CD Writer is an
acronym for the Department of Defense Core Document System.
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. twe deoumen Dedelapmentaysemn

CDWriter

Department of Defense

Core Document System

Figure 3-3. CD Writer Introduction Screen
The application will then display the Core Document Main Menu Screen shown in Figure 3-9.

Password
The “Password” button allows users to change their password for the Integrated PPI Suite.

=-| Change Password

Enter Hew Oracle Password: n

Yerify Hew Oracle Password: I

Password must be at least 6 characters in length,

Uze a combination of letters and nunbers, Include
nunbers within the password, not at the beginning

or end, Change your password every 90 days or

sooner,
OK | CAMCEL |

Figure 3-4. Change Password Screen

To change a user’s password from the PPI Application Menu (Figure 3-2), press either the [Tab]
or [Enter] key to highlight the “Password” option. After the option is selected, press the [Space
Bar], or click the left button of the mouse. The application will display a message asking the
user, if they wish to change their Oracle or UNIX password. Select the “Oracle” button and the
application will display the “Change Password” Dialog Box shown in Figure 3-4. After entering
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the user’s new password, press the [Tab] key to go to the “Verify New Oracle Password” block,
then press the “OK” button. Click “CANCEL” to retain user’s old password.

PERSACTION

As previously mentioned, the PPl Application Main Menu is the entry point into the
PERSACTION, COREDOC, TRAIN, and Regional Application. COREDOC is accessed in two
ways. First, users can access COREDOC by clicking on the “COREDOC” option on the PPI
Application Main Menu. Another way to access COREDOC is through the PERSACTION
software. Upon selection of the “PERSACTION” option, the application takes users to the In
Box screen shown in Figure 3-5.

= INBOX NAME: CPO_CHIEF k2
Request # PP 3ER GR Organization Form Type Euployee FHCIA
97AF000001 G5 03158 05 4LOJFEZVCC 5F52  PREOMOTION ABZZZZ MARY A ¥ E
Q7AFO0000Z G5 0326 04 SP=UFTIJISVIFC 5F52  PEOMOTION ABZZZZ MARY A T
QTAFOO000S WG 5563 05 ALOJFHRGLGHMCC 3F5Z PROMOTION AEUAN ROEERT M T
A7AFOO00Z2 G5 0203 06 ALOJFDHVDEPC 3F52 FILL/BRECRUIT T
Q7AFO000Z7 3F52  FILL/RECEUIT ¥
k2

W columti: Y=Indicates notes are attached to the regquest.

C column: Y=Indicatezs a core document is attached to the redquest.

5 column: ¥=PTI Response read PE=PTI Fesponse received but not read ?=Waiting £/Response
A column: A=Indicates document(s) are attached.

‘ Create | Edit | Coordinate PTI | Print Batch Print ‘ Attach Doc

‘ Hotes | Delete | Cloze ‘ Sort | Track | Reports ‘ Quit

Figure 3-5. PERSACTION In Box Screen

The In Box screen, which shows active records, contains actions that the user created, as well as
actions that were sent to the user for coordination or processing. These actions remain in the In
Box until they are coordinated (forwarded) to another In Box, deleted by the originator, or closed
by the Civilian Personnel Office.

Initially, the personnel actions are shown on the screen in ascending order by Request Number.
The top request is highlighted when this screen is displayed. The highlighted record is
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indicated by a black rectangle around all the information on that line. To select another
request, use the [Up/Down Arrow] key or the mouse to move through the list and highlight the
appropriate selection. If there are several pages of requests in the In Box, the [Page Up], [Page
Down] , or [Arrow] keys, as well as the scroll bar, provide faster means for moving through the
In Box.

Figure 3-5 shows an In Box screen with the first record highlighted. The In Box contains nine
columns that provide general information for each personnel action, including the Request
Number; Pay Plan (PP); Series; Grade; Organizational code; Form Used; Type of Action;
Employee Name; whether notes are attached to the action; and if the action was submitted to
DCPDS. The “*NCSA” column provides information concerning a personnel action. The asterisk
indicates that a legend is provided at the bottom screen. The “C” column with a “Y” denotes
whether a core document was created for the highlighted personnel action. If the “N” or “C”
column is blank, then no attachment exists for the corresponding action. The “S”” column indicates
the status of the Personnel Action Request once it is submitted to DCPDS. The “A” column
indicates documents (existing core documents, including DOS based documents, organizational
charts, memos, etc.) are attached.

To create a Personnel Action Request, click the “CREATE” button at the bottom of the In Box
screen. The application will display the Create a Record dialog box shown in Figure 3-6. Users
have the choice of selecting either the Personnel Action Request or one of the local national
forms, such as AE Form 690-60A. Click the first option and then the “OK” command button.
The Actions Screen (Figure 3-6.a) is displayed immediately after Figure 3-7 is displayed. Select
the type of personnel action to be processed by using the scroll bar on the right or use the Find
function. Highlight the desired action with the cursor and click “OK”. Figure 3-7 is displayed
with the nature of action data block completed. If the “CANCEL” command button is clicked,
the software returns to the In Box.

= CREATE RECORD = ACTIONS
‘Standard Form 5 [CA} Find I X
AE Form 690-604 [CL])
SF52-taly [CL] Schions
5F52-Belgium [CL) .
SF52-Korea [CL) ALTH AUO [ ]
Form 11- Japan[CL]) A [ =
R D
CAMCELLATION
CHG DATA ELEMENT =
|l o
Lel | E3
0Ok i | Cancel | Find I ok I Cancel
Figure 3-6. Create a Record Dialog Box Figure 3-6.a. Actions Screen
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The Personnel Action Request form (Figure 3-7) shown on the screen is essentially identical to
the paper form, except it appears as a series of five screens or pages. Users may press either the
[Tab] or [Enter] key, or use the mouse to move from one block to another. Users may also
move to another page by clicking the desired page number button on the lower left hand corner of
the Personnel Action Request page.

“COREDOC” and “ATTACH?” buttons are also located on the Personnel Action Request Form.
Click the “COREDOC” button to access the COREDOC System. The “ATTACH?” button allows
users to append a previously created core document to a Personnel Action Request.

= REQUEST FOR PERSONNEL ACTION Page 1 ofb

Current Status Send to Hext Preset Coordination
I Coord

PART A - Requesting Office

Actions Requested Request Hunber
|REALIGNMENT HTE: I | |96AF000154
For Additional Infornation Call <{Hame and Telephone Humber} Prop. Dt {HHDDYY}
Action Requested By Action Authorized By

Hane Hane

Title Title

Request Date I Concurrence Date I

PART B - For Preparation of SF 50 {Use only codes in FPH Supplenent 292-1,
Show all dates - HH-DD-YY}

SS5AN Hame f{Last, First, Hiddle} 0oB  (HHDDYY} |Eff. Dt {HADDYY}

EijEdjdjj oK | £3EY ﬁi&ﬁ@%&il ATTACH | COHEDOCl CAMCEL

Figure 3-7. Page One of the Personnel Action Request Form
Once the Personnel Action Request has been created, users can select the “ATTACH” button.

The application will display the Attach Core Document dialog box that contains all the core
documents that were created by that user (Figure 3-8).
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Find I%

CPCH Hame PP 3eHes Gr Title __|
BPHAVELOD1 HAVELOD1 GS o1& 09 Safety and Occupatii
9PHAVELDDZ HAVELDD1 GS o018 09 Safety and Occupat]
SPHAVELDD3 HAVELDD1 GS o018 09 Safety and Occupati
9PCOREDDOD SAHODOD1 GS 0018 10 Safety and Occupadti
9PHAVELZDO SAHOODOD1 GS o018 10 Safety and Occupat]

THMPODZEE GS 0203 05 Personnel Clerik{Offi
9P0OX001 51 THMPOD299 GS 0318 04 Secretary

AFODD3 GS 0318 04 Secretary

TMPOD3:44 GS 0318 04 Secretary

TMPOD342 GS 0318 04 Secretary (Office A

TMPOD285 GS 0318 04 Secretary {Typing)

TMPODZ94 GS 0316 04 Secretary (Typing) |/
J=I 1 el

Find oK | Cancell

Figure 3-8. Attach Core Document Screen

The Attach Core Document dialog box shown in Figure 3-8 displays the core document in
Civilian Position Control Number (CPCN) order. To view the entire list, scroll through the list
of core documents or use the “Find” feature. Click the horizontal scroll bar to view the CPCN,
pay plan, series, grade, title, organization name, incumbent name, and title of a position.

Highlight the core document and click the “OK” button, the application will then attach the core
document to the Personnel Action Request.

Once the user attaches a core document, the Personnel Action Request will then be flagged with
a “Y” in the “C” column within the PERSACTION In Box. Only the user that created the core
document or the COREDOC System Administrator can edit, attach, or unattach a core document.

If the user wishes to attach a different core document, users must return to the Inbox, select the
appropriate SF-52, and then select the “ATTACH” button again. A pop-up window will then
appear. Click the “ATTACH NEW?” button. The application will again provide the user with a
list of the core documents that were previously created. If the user needs to unattach the core
document, they can select the “ATTACH” button again. This time the user should select the
“UNATTACH?” button.

COREDOC Main Menu

The first screen to appear after opening the COREDOC system is the Main Menu. The Main
Menu is the first operational screen and central point for performing the basic functions in the
program.
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REGIONAL APPLICATION
File LWtility Window Help
= Core Document Development System

COREDOC DEVELOFMENT SYSTEM

Choose an opton from the menw.

Count: =0 -
Figure 3-9. Core Document Main Menu

The three options for performing basic COREDOC functions are listed across the top of the
screen. They are:

» File. This option allows users to perform a variety of functions. Users can create, delete,
view, print, import, copy, and rename any core document within their In Box.

o Utility. This option allows users to establish system generated defaults. In addition,
classification specialists can assign a Civilian Personnel Control Number (CPCN) to a core
document or position description.

* Help. Clicking the “Help” menu allows users to view four options, “View Coredoc Manual”,
“Print Coredoc Manual”, “Show Keys, and “About Coredoc CD Writer”.

The Main Menu options i.e., File, Utility, and Help have drop-down menus with several sub-
options. Users can use the mouse to select one of these options from the menu. Users can also
press the [Page Up/Page Down] arrow keys to move between the options. The application will
then display the System Default screen also found under the Utility Menu.

File Menu

The first option listed on the Main Menu screen is “File”, which has eleven options. The File
Menu contains most of the functions involving the creation, modification, and deletion of core
documents.

COREDOC 3-9



Chapter Three: COREDOC Operating Procedures

Hew
Open...
Delete...
View...
Print...

Import CDs...

Export CDs...

Use Standard CDs...
View Standard CDs...

Copy...
Rename...

Exit

Figure 3-10. File Menu

The File options shown in Figure 3-10 are described below:

New. This option allows users to create a new core document. For instructions on how to
create a core document see CHAPTER FOUR of this guide.

Open. This option allows users to open an existing core document from users folder. For
instructions on how to use the edit an existing core document, see Chapter Five of this guide.

Delete. This option allows users to delete an existing core document from users folder.

View. This option allows users to view a core document on screen. Click the File Option
and then select the View Option. For instructions on how to use the View function, see either
Chapters four or five of this guide.

Print. This option allows users to print a copy of a core document.

Import CD. Users have the capability to import regular or standard core documents into the
Integrated PPI Suite from the PC version of CD Writer (version 2.0) software package. This
function is normally restricted to the system administrator. For more information, see System
Administration Functions section of this chapter or the Administration Guide for the
Integrated PPI Suite.

Export CD. Users will have the capability to export core documents to another source.

Use Standard CDs. Users have the capability to copy a core document from the standard
library.

View Standard CDs. Users have the capability to view a standard core document.

Copy. This option allows users to duplicate an existing regular or standard core document in
their directory.

Rename. This option allows users to assign a new name to an existing regular or standard
core document in the users folder.
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e Exit. This option allows users to return to the Core Document Main Menu Screen, (Figure
3-10).

Utility Menu

The Utility Menu contains two options, “System Default” and “Assign CPCN." The “System
Default” option is available to any user of the COREDOC application. A third option, “System
Administration” is available to persons who have been designated as System Administrators for
the Integrated PPl Suite. The “Assign CPCN” option is available to persons who are designated
as “Classifiers” in the Integrated PPl Suite. Classifiers are normally located in the civilian
personnel office.

System Default Menu

When users first use the software, they will be prompted to complete the “System Default
Screen” (Figure 3-11). This screen allows users to designate certain System Defaults and
establish a standard Goal and Organization Name for each core document generated.

The COREDOC software has predetermined defaults that may or may not be compatible with
users agency requirements. Users will need to review these defaults and make appropriate
changes so the core documents that users create will be in the right format and printed using their
printer equipment.

Core Document Development System - User Default Information
A Code:
Oracle User ID:  DOCUMENT_TESTERI seney=e
DN
Crutput Formeat: Om/CHf Settings For:
L. oo Import CDs
Core Doconent Critical/Noncritical
. Export CDs
Position Descrinti Percentage for FWS Positions
Show KSA Linkage To Specific Duties
Automatic Staffing K5A Selections
Ovrganization Naone:
TEST UNIT
Ovganization Goals:
|
Save Exit
Count: ™1 <Insert=

Figure 3-11. System Default Screen
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The User Default Information screen allows users to enter a standard goal and mission statement
for their organizational component. Users can determine the type of output desired, e.g., core
document or position description. Additionally, users can determine what type of settings, if any,
that they wish to view during the process of generating a core document.

Oracle User Id. The “Oracle User Id” field contain the Oracle User ldentification code
assigned to the user. This field can not be modified from the “User Default Information” screen.

Agency Code. This designates the format of the core document, in particular the performance
management plan. The System Default is “DD." Users may select from five other choices,
including Air Force, Army, Marines, National Guard Bureau, and Navy. Click the “Edit” button
to get the list of Agencies.

If users are employed by a Defense agency or field activity such as the Defense Finance and
Accounting Service (DFAS), the Defense Information Systems Agency (DISA), or the Defense
Logistics Agency (DLA), users should retain the standard system default (DD) format.

All other users should change the format to match their parent agency. If users are unsure what
format to select, they should contact their civilian personnel office for guidance.

The following are brief descriptions of the basic differences in each format:

* Air Force. The Air Force duty statements are merged with the performance requirements.
No Performance Management Plan screen will be displayed.

* Army. The Army has individual task statements for each duty. The statement, “Other duties
as assigned” appears automatically, but without an indicated percentage of time. When
activated, the performance management plan automatically includes the appropriate version
of the Army unique TAPES.

* Navy. The Navy does not have individual tasks statements for each duty . The “Other duties
as assigned” statement automatically appears when selected duties fall within the 90 to 99%
range. A percentage of time equal to the difference between the total for the selected duties
and 100% is assigned to the “Other duties as assigned” statement.

* Other DoD agencies. The only difference between the DoD, National Guard Bureau, and
Navy formats is the performance management plan. All other areas are the same.

Output format

Users have the capability to create a standard position description or a core document. The
position description does not contain performance management plan or specific performance
standards. The Standard System Default format is a CORE DOCUMENT. It is recommended
that users retain this as their default. Once users have created a core document, there are various
report options that can be viewed or printed during the edit process.
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Settings

Critical/Noncritical. The software automatically designates all selected duties as critical when
this setting is activated.

Percentage Of FWS Positions. Users should not select this option unless their Agency requires
duty percentages to appear for wage grade positions. The “Percentage Of Federal Wage System
(FWS) Positions” setting was specifically developed for the Department of the Army.

Show KSA Linkage To Specific Duties. This default setting allows users to show the linkage
between a selected duty statement and competency (Knowledge, Skill, or Ability) for a core
document. This option was specifically requested by Department of the Air Force. To
disengage, click the checkbox with the mouse.

Organization Name and Goals

Default Goals and Organization Name establishes the standard information that can be selected
to appear on all reports created with COREDOC system. This standard information includes
“Users Organization Name” and “Users Organization Goals." We recommend that this standard
information be provided whenever possible to facilitate the creation of core documents. During
the creation process, users will be asked to provide information about their organization. Users
will also be given the option of selecting Standard Goals. The information users provided on the
System Default Screen will automatically appear in the core document eliminating the need to
type this information.

Once users have selected all of the system defaults, click the “Save” button, to save the selected
ones and “Exit” button to exit the “User Default Information” screen.

Import and Export CDs. The “Import CD” option is available to system administrators only.
The “Export CDs” option is currently under development.

HELP Menu

View COREDOC Manual
Print COREDOC Manual

Help System...
Ahout CDAriter...

Figure 3-12. Help Menu

Users can find this option at the right top corner of the Main Menu. The Help function has four
options.
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* View COREDOC Manual. Users have the capability to view an on-line user manual
without exiting the COREDOC program.

* Print COREDOC Manual. Users have the option to print a copy of this on-line user
manual without exiting the COREDOC program.

* Help System. This option provides general information about the purpose and functionality
contained in the COREDOC software.

* About COREDOC (CD Writer). This option provides general information about the
COREDOC software, such as the version number, etc.

Viewing a Core Document

Users can view and print a core document by selecting the “View” option from the Core
Document Edit Menu. A pop-up message telling users how to send the document to the printer
will appear as shown in Figure 3-13.

- Action - Yiew Report

If you decide to print this report from the
Report Previewer by pressing the Print
button, you must manually select the printex
from the File Menu (Choose Printexjin the
Previewer.

o |

Figure 3-13. Action -- View Report

To view the Core Document, use the mouse to highlight the “Previewer” option and click the
“OK” button. The COREDOC application will then display the “Previewer” screen shown in
Figure 3-14.

The “Previewer” screen allows users to view an entire core document or report before they print
it. Users can view a whole page at a time or various elements of the report.
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For illustration purposes, Figure 3-14 displays the “Previewer” screen for the secretarial position.

File Edit Windows

Reports: cordocda: Previewer

iy Hext

2534 | Last | Page:

|l Print Close Hew

Lol

CORE DOCUMENRT

DOCUMENT HAME/#: TMPOD239

Purpose of positiom:

organization.

organization:
Defense Ryency

oxganization Goals:

II. MATOR. DUTIES

A . Duty

(3%)

I. POSITION AHD OBGANIZATION IKFOBRMATION
Position:
Secretary R 65031804

The secretary serves as the primcipal office assistant performing
administrative and clerical duties in support of the work of a small or medium
size orgamizatiom, where the reguived coordination is primarily intermal to the

Prepaves corrvespomdence, reports, and other decuments.

RS =]

Figure 3-14. Core Document - Print Previewer Screen

In addition to the standard Windows elements found in the COREDOC system, the “Previewer”
screens contain a menu bar, seven command buttons, a page finder, two scroll bars, and a zoom
feature. To return to the parameter screen, click “CLOSE”.

The Menu Bar contains four options: “File,” “Edit,” “Windows,” and “Help”. The Help option
provides information on setting up a printer or saving the report to a file. To access one of these
menu options, press the underlined key on the keyboard or click the option with the mouse.

If a user decides to print a core document, select the “choose printer” option under the “File”
menu. After a printer is selected, users may click the “Print” button to open the “Print Job”

dialog box.

Use one or more of the following options to navigate through the “Previewer” screens:

» Scroll Bars. The horizontal scroll bar provides a view of the entire screen from the left to
the right margins. To locate the last record on the report, drag the scroll box located between
the arrows of the vertical scroll bar.
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Zoom Feature. The “zoom out” and “zoom in” options are located next to the horizontal
scroll bar at the bottom of the “Previewer” screen. They provide the capability to focus on a
specific section of the screen. To use the “zoom in” feature, click and drag the object to any
point on the “Previewer” screen. The application then automatically enlarges that part on the
report to 100%. Click the “zoom out” object to normalize the screen.

Command Buttons. The “FIRST” and “LAST” options display the first or last page of the
report, respectfully. The “NEXT” option moves the screen pointer to the first record on the
next screen.

Page Finder. The “Page Finder” option is located next to the “LAST” command button on
the top of the “Previewer” screen. To view page seven of the report, enter “7” in the “page
finder” block and click the “PAGE” button. The application quickly moves the screen
pointer to the first record on the designated page.

Printing a Core Document

In addition to viewing a report, the application allows users to print reports and save them to a

file.

Selecting a Printer

To choose a printer click the “File” Option on the menu of the report. Users will then see a list
of options. Select the “Choose Printer” option by clicking on it. The application will then
display the “Printer Chooser” screen shown in Figure 3-15.

= Printer Chooser
Pre-defined Printers:
dZe p0179ps === Printer PO179 in D2 East A
d2w p0175ps === Printer PO175 in D2 East J

daw_pd177ps === Pranter PO177 m D2 East
c2_pll33ps === Panter PO033 in C-wing
|

I~ =
Printer Type: Printer Hame:
Postscriptl | I

B B

Figure 3-15. Print Chooser Dialog Box
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» From the list of printers in pre-defined printers choose the correct printer by clicking it. The
name then appears in Printer Name field. Click the “OK” button and the core document and
the application will display the “Print Job” dialog box shown in Figure 3-16. To cancel the
print job, click “CANCEL” button.

Saving a Core Document as a File

Click the “SAVE” button on the “Print Job” screen activates the “Save File Dialog” box shown
in Figure 3-16.

Save File Dialog

Filter

ivaripersacts

Directories

4
fvarfpersactf.. J

[ 1=

fvarfpersactidbupdate

fvarifpersactiogs

fvaripersactireceive

#

|

Flease enter the filename:

pers_new.lis

Figure 3-16. Save File Dialog Box

The application assigns a default name to the report. However, users may change a document’s
name for the purpose of saving it as a text file. To rename the file, highlight the file listed in the
“Please enter the filename” block, and use the delete key to clear the block. Once the block is
clear enter a new name for the file.

In addition to modifying the name of the file, users may designate the directory. To designate a
different directory for the file, users must first highlight the directory using the vertical and
horizontal scroll bars. After the directory is highlighted, click the “OK” button to insert the file
into the selected directory.
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Reports

Users can view and print a core document by selecting “Reports” option from the Core
Document Edit Menu. After users have selected the Reports option, a list of eight options will
appear, including Core Document, Core Document (no competencies), Position Description,
Knowledges, Skills, and Abilities, KSAs (no competencies), Performance Plan, Evaluation, and
Occupational Series List. If Occupational Series List is selected, the application will display a
pull down menu allowing users to print the report “in title” (alphabetical) or “numeric” (series)
order (see appendixes B and C of this guide).

Core Document

Core Document (Ho Comps)
Position Description
Knowledges, Skills and Abilities
KSas (Mo Comps)
Performance Plan

Evaluation

Sxreny Bheal

Occupational Seres List -

Figure 3-17. Report Menu

Use the mouse to select any of the options from this menu. The application will display “Report
Destination” screen shown in Figure 3-18.

= Report Destination

Select Report Destination:z

+ Previewer

Ok | Cancel |

Figure 3-18. Report Destination Screen

Click the check box next to “Printer” and the application will display the “Print Job” Dialog Box.
It is recommend that users first view the report before electing to print it. To view the Core
Document, use the mouse to highlight the “Previewer” option and click the “OK” button.

A pop-up message telling users how to print the document to the printer will appear as shown in
Figure 3-109.
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Action - View Report

If you decide to print this report
fron the Report Previewer by
0 pressing the Print button, you

nust manually select the printer
fron the File Henu {Choose Printer}
in the Previewer.

Figure 3-19. Action -- View Report

To view the Core Document, click the “OK” button. The COREDOC application will then
display the “Previewer” screen (Figure 3-14). The “Previewer” screen allows users to view an
entire core document or report before it is printed. Users can view a single page at a time or
various elements of the report.

If the user decides to print a core document, select the “choose printer” option under the “File”
menu. After a printer is selected, users may click the “Print” button to open the “Print Job”
dialog box.

After the print job is completed, the application will return the user to the Report Menu.

System Administration Functions

NOTE: This function only applies to systems administrators and those given access to the
system administration role within COREDOC. A special username and password are needed to
access this function.

The COREDOC application allows a system administrator to perform routine maintenance
functions for the typical COREDOC user. This Guide does not contain detailed instructions for
the system administration functions within the COREDOC system. A separate document set
provides step-by-step instructions for the system administration functions within the Integrated
PPI Suite.

To access the System Administration Menu within COREDOC, select the “Utility” option from
the COREDOC Main Menu Screen by clicking it. The application will then provide system
administrators with a pull down menu that contains “System Defaults” and “System
Administration” options.

Click the “System Administration” option with the mouse. The application will then display the
Core Document Development System Administration screen.

System administrators can perform a variety of functions within COREDOC. Authorized users
can obtain a list of available options by clicking “Action”. The application will provide users
with a pull down menu containing eleven system administrative functions. These functions
include:
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Mass Ownership Change. A system administrator can change the ownership of COREDOC
account. If a particular user is transferred or leaves an organization their user account will
not be accessible to any other user, unless they have access to their password. In such a case,
the system administrator can change the ownership of that particular account to another
person so that the core documents can be processed.

Mass CPO ID Change. The Mass Civilian Personnel Office (CPO) Identification Number
option allows a system administrator to designate a New CPO identification number for all
the core documents within the COREDOC application.

Mass Delete. The Mass Delete option allows a system administrator to remove all of the
core documents from a particular user’s account.

Delete CPCN. The Delete CPCN option allows a system administrator to remove a core
document AND its Civilian Position Control Number (CPCN) from any user’s In Box.

Delete Standard CDs. The Delete Standard CDs option allows a system administrator to
remove any standard core document from the COREDOC system.

Remove CD Locks. The Remove CD Locks option is used when a user experiences a
problem exiting from a screen within the COREDOC application. Generally, users will
experience this problem when they select two or more options simultaneously.

Modify User Default Information. The Modify User Default Information option allows a
system administrator to change the user default information for a particular account. This
screen allows users to designate certain system defaults, establish a standard goal, and
organization name for each core document generated. Users may also modify the
information on the “System Default” screen by accessing the “Utility” menu

Import PC Core Documents. The Import PC Core Documents option allows system
administrators to import core documents created by CDWriter version 1.4a (PC version) into
an individual user’s in box or the Standard Library within the Integrated PPI Suite.

View Import Log File. The View Import Log File option allows a system administrator to
view and print a listing of all the core documents previously imported into the Integrated PPI
Suite.

Delete Import File. The Delete Import File option allows system administrators to remove a
core document that was previously imported into the Integrated PPI Suite.

COREDOC 3-20



CHAPTER FOUR: CREATING ACORE DOCUMENT

General

Selecting Occupational Series

Naming Core Documents

Selecting Duties

Selecting Supplemental Information

Assigning Percentages and Duty Criteria
Selecting Knowledge, Skills, and Abilities (KSAS)
Goals and Purpose Requirements

Establishing Performance Standards

Core Document Summary

This chapter guides users through the process of creating a new core document.

4-2
4-2

4-6

4-11
4-15
4-16
4-18
4-19
4-20

COREDOC 4-1



Chapter Four: Creating a Core Document

General

This chapter guides users through the process of creating a new core document. Users
MUST designate System Defaults and establish Default Goals and Organization Name
before they start creating core documents. First time users of the application should
return to the UTILITY section in CHAPTER THREE for instructions on how to establish
these defaults. To initiate the creation process from the Core Document Main Menu click
“Eile” and then “New” options.

Selecting Occupations

The first part of the series and occupations selection process requires making a choice
from the Primary Occupation screen. The Primary Occupation screen lists all of the
available series and occupations in the current version of COREDOC (Figure 4-1).

= Occupations to Select From
Find 03%
SIS Menu AG Title
0305 305 DD Mail and Fle Clerk A |
03186 J186A DD Secret - SmallfMedium Off.
0318 J16e DD Secretary - Medium/Large Off.
0318 J6C DD Secretary-Large, Complex Org
0322 322 DD Clerk- Typist
0326 326 DD Office Automation
0332 332 DD Computer Operator
0334 334CS DD Computer Specialist
0334 334DBM DD Computer Specialist - Data Base Management
0334 I34EA DD Computer Specialist - Equipment Analysis
0334 J34HET DD Computer Specialist - Hetwork
0334 334P4 DD Computer Specialist - Programning & Systems Analysis ]
=l | ]
Find OK | Cancell

Figure 4-1. Occupations Dialog Box

This version of COREDOC covers a variety of different wage grade (WG) and general
schedule (GS) occupations (see appendixes A and B of this guide). Users can click the
scroll bar on the right side of the list to move through the list of occupations. COREDOC
has been programmed to conduct alphanumeric searches in order to expedite locating a
specific series or occupation. Type the first letter of the job title after the “%” sign in the
Find box and click the “Find” button. After selecting a particular occupation, click the
“OK” button. To find all the Occupations starting with “EL”, e.g., Electrical Engineers,
enter “EL%” in the Find box. To locate all the occupations in the “0200” series, enter
“02%” in the find box.
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NOTE: Several series have been further defined into a number of occupations. For
example, 0318 has other associated occupations listed as 318A, 318B, etc. In addition,
there are several series listed as Primary Occupations that require users to select duties
from two or more occupational menus. This usually applies when two or more wage
occupations of equivalent grade are used in the core document creation process. If users
select one of these series, the software will return users to the Primary Occupation screen.
Users should select another series with an associated occupation before they can proceed
with the core document creation process.

Click the “OK” button, the application will display the message “Please Confirm The
Following Work Situation” at the top of the Core Document Screen (Figure 4-2.

Core Document Development System - New Core Document

PLERSE CONFIRH THE FOLLOHIHG HORK SITUATION: Occupational Henui 3184
Occupation: 3ecretary - SmallfMedium Off., G3-0318

The work described is typical of secretarial positions located in small
organizations in the Department of Defense,

The secretary perforns various clerical and administrative duties supporting
the work of the organization, The secretary provides assistance to one or
nore individuals as the principal clerk of the office.

HORK SITUATIOH A: The work unit may be small, of linited complexity, or it
nay be nediun in size and contain several subordinate units or groups, In
either case, coordination iz primarily internal to the organization and work
processes are procedural,

The supervizor directs the staff prinarily through face-to-face contacts and
sinple, informal procedures. There are few complicated problemns of
coordination that require fornal procedures and controls for adequate
solution.

GRADE LEYELS: The duties under this menu reflect G5-4 and G5-5 levels, If
the user needs to create a Core Docunent for G5-318-3 for recruitment
purposes, select duties typical of G5-4, and edit Factor 2 {Supervisory
Controls} by selecting Factor Level 2-1,

Infonmation | Continue | Exit |
Menu Mode = Newr
Count: *1

Figure 4-2. Core Document Screen - Work Situation Screen
The Work Situation screen has three control buttons, “Information”, “Continue”, and “Exit”.

After the occupational series is selected, users must review the work situation and
classification standards information to verify that the selected series with associated Work
Situation is appropriate. To read the information contained in this screen, users can use
the [Arrow] keys or click the scroll bar with their mouse.
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User may view additional information concerning an occupational series by clicking the
“Information” button. The application will then display the Occupation Information
screen shown in Figure 4-3.

i Occupation Information for CDWriter 318A Menu

Contents: MORK SITURTION
GRADE COHMTROLLING DUTIES
EXCLUSIDHS

TITLE HELP

CLASSIFICATION CRITERIA USED

HORK SITUATION

The conditions described are representative of Mork Situation A of the position
classification standard for Secretary, G5-318, Hork Situation A; The
organization iz small and of linited complexity., HAlthough the organization nay
include several subordinate sections or subgroups, the supervisor directs the
staff primarily through face-to-face contacts and sinple, informal procedures.,
Hithin the supervisor’s organization there are few conplicated problemns of
coordination that require fornal procedures and controls for adequate solution,

GRADE COHTROLLIWG DUTIES

The first four duties (typing, calendar maintenance, receptionist, and reviewing
and proceszing inconing nail} are the most significant aspects of the
secretarial work and should comprise a significant percentage of the secretary’s
time, To create a core docunent at a particular grade level, be sure that these
duties have been selected at that grade level and that together they comprisze at
least 25% of the secretary”s time. At least two of these four duties should be
included in the core document,

EXCLUSIDHS

Print I

Figure 4-3. Occupational Information for CD Writer - 318A Menu Screen

The Occupation Information screen has detailed position classification information about
the selected series and occupation which should be read before proceeding. Users can
click the scroll bar to navigate through this information. This information can be printed
by clicking the “Print” button on the bottom of the screen. Click the “Exit” button to
return to the previous screen.

If the selected series or work situation is inappropriate, click the “Exit” button. The
application will then display a Confirmation screen that displays the message, “Do You
wish to abandon this series?”. Click the “Yes” button. The application will return the
user to the Core Document Main Menu screen (Figure 3-8).

If the selected series and occupation are appropriate, click the “Continue” button.
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The application will display either the CD Type dialog box (Figure 4-4) or the Enter CD
Name dialog box (Figure 4-5) depending on the user’s individual profile. Only persons
designated as a “Classifier” in the COREDOC application will have access to the CD
Type dialog box.

The CD Type dialog box allows classifiers to select between two types of Core
Documents, a Regular Core Document or Standard Core Document.

If the classifier elects to create a “Standard CD”, anyone having access to the COREDOC
application can view, copy, or print it. Therefore, users are cautioned not to generate a
standard core document that is based on unique duty requirements or special
qualifications of the incumbent.

Action - CD Type

Please select the CD type that
you wizh to create!

< Regular CD + Standard CD
Ok I

Figure 4-4. CD Type Dialog Box

To select one of these options, click the check box located next to the desired option.
Click the “OK” button to continue with the creation process.

For illustration purposes, the classifier selects the “Regular CD” option. The application
will then display the Enter CD Name dialog box shown in Figure 4-5. Users will notice
that the COREDOC system automatically generated a CD Name of “TMP00279” to the
core document.

Action - Enter CD Name

CD Hane: |[THPO0279

Ok | Help |

Figure 4-5. Enter CD Name Dialog Box

Click the “Ok” button to accept this number or enter user specific number and click
ILOKli.
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Naming Users Core Documents

As mentioned earlier, the software provides a default name for each core document users
are creating. The naming convention will vary depending on the type of core document
generated. Using this name as an identifier, the COREDOC software can save the
document at each stage of the creation process. Additionally, this permits the user to
retrieve a document, even if, they can’t complete the creation process.

Regular core documents will have a system generated core document name beginning
with TMP and ending with a sequential number (e.g., the first CD Name would be
TMP00001, the next TMP00002, etc.). However, it is recommended that users establish
their own naming convention. Uers can enter any identifier that does not exceed the
allocated space of eight alpha-numeric characters.

Standard core documents will have a system generated name comprised of four
components: the abbreviation, “STD”, the user’s two digit agency code, the four digit
occupational series, and a sequential number. For example, if the user wants to create a
new standard core document for a GS-0334-12, Computer Specialist for the Air Force,
the system will automatically name it “STDAF0334000000001”. As mentioned earlier,
users may establish their own naming convention. However, the overall name must be
unique within the system.

After the core document is added to the COREDOC table, the application will display the
Duty List screen (Figure 4-6).

Selecting Duties

The next screen shows the Duty List for the occupation selected. This is the first phase of
the duty selection process. The number of duties listed varies depending on the
occupational series selected by the user. For example, most wage grade occupations have
one duty listed; however, several general schedule occupations have as many as sixteen
duty lists. The Duty List screen has the two control buttons, “Select All” and “Continue”.
The “Select All” button allows users to choose all the duties listed for the occupational
series. Click the “Continue” button to proceed with the next step in the selection process.
Users are cautioned to click the “Continue” button AFTER they have made all of their
duty selections.

Users can select duties by clicking the check boxes next to the Duty Title. Users do not
have to use every duty selected in this screen. During the next phase of the duty selection
process, users will conduct a comprehensive evaluation of these duties to determine
which ones will appear in their core document.
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== Duty List for: G5-0318 Secretary - SmallMedium Off.

DUTY SELECTIOH:
Select the duties to include in the core document.

Grade Select /

Selected Unselect Duty Title

A E Prepares correspondence, reports, etc
-1 HMaintains calendars and schedules
Receives and screens calls and visitors
Reads and processes incoming mail
Travel arrangements

Performs stenography

Time and attendance

Uses office automation softvsare
Establishes/maintains subject-matter files
Advisesftrains staff on office procedures
frranges conferences and meetings
Requisitions office supplies, etc

T rXSC - I opTMmMme o m

Processes personnel actions and training requests

SN TR TS TS U T T S S S S

Select All | Continue |

Figure 4-6. Duty List for: GS- 0318 Secretary - Small/Medium Office Screen

To make selections from the Duty List screen, click the check box in front of the Duty
users want to select. When a select is made, a check box will be marked adjacent to the
duty AND the application will automatically take the user to the Duty Classification
Levels Screen shown in Figure 4-7. The Duty Classification Levels Screen shows the
levels for each duty statement. For each level indicated by the cursor, a description
explaining that particular level is displayed at the bottom of the screen. Users can move
through the description by clicking the scroll bar.

' Hint: Occasionally users have reported that the scroll bar sometimes becomes
inactivated, even if, more information is available for display. When this occurs, users
should place the cursor in the text block and click the RIGHT mouse button. The scroll
bar will reset and allow users to navigate through the rest of the information.

After each duty title is selected, the application will return the user to the Duty Selection
screen (Figure 4-6). After the last duty is selected, click the “Continue” button at the
bottom of the Duty Select Screen.
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Duty Classification Levels for. A. Prepares correspondence, reporis, etc

LEYEL SELECTIOH: Return to Duty Display Duty
Click with the nouse on Selection screen Statenent

checkbox for level desired,
Cancel | Statement |

Level Classification
[[] 1 secretary Gs-0318-04
| 2 Secretary GS-0318-04
| 3 Secretary GS-0318-05
4  Secretary GS-0318-05

Level 1 Description

[Prepares comrespondence, reports, and other documents from handwritten drafts using a '
manual or electric typewriter. Responsible for grammar, spelling, capitalization, punctuation,
and appropriate format. Work requires a gualified typist (40 wpm). Works under close
supetrvision while gaining familiarty with the organization and assignments. (Typical of
G3-318-4)

4

Figure 4-7. Duty Classification Levels Screen for: A. Prepares Correspondences,
Reports, etc. Screen

Users can return to the duty selection screen without selecting a grade level, by clicking
the “Cancel” button.

« Note: As mentioned previously, a user can elect to click the “Select All” button from
the Duty List screen (Figure 4-6). The application will then automatically mark each
check box adjacent to the duty AND the application will take the user to the Duty
Classification Levels Screen (Figure 4-7). Users can select a grade level by clicking the
box adjacent to it. Users may remove a duty from the Core Document by clicking the
“SKIP” button.

Users can also view the individual duty statements by clicking the *“Statement” button.
The application will then display the Duty Statement Screen shown in Figure 4-8.
Clicking the “Return” command button will take the user back to the Duty Selection
Screen (Figure 4-6).
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Level 1. Secretary G5-0318-04

—

Figure 4-8. Duty Statement Screen for Level 1 Screen
After users have selected the required duties for that job, click the “Continue” button at

the bottom of the Duty Selection Screen. The application will display the Duty List
Opportunity screen shown in Figure 4-9.

COREDOC 4-9



Chapter Four: Creating a Core Document

== Duty List for: G5-0318 Secretary - SmallMedium Off.

Select one of the following options by clicking on the button:

Continue I Continue to the next step == Supplementary Selection.

Select additionals duties from another Occupational Series Henu,

3ave &guit I Save all input and return to the main menu,

Abandon I Cancel {Delete} thisz Occupational Series and return to main menu,
Previous I Return to previous screen -- Duty Selection,

Figure 4-9. Duty List Opportunity Screen

Figure 4-9 contains five command buttons.

Continue. This option allows users to proceed to the next creation screen.

New Series. When users select this option, the application will return them to the
Primary Occupation List screen. They will have the capability to select duties from
another occupational menu. When the Primary Occupation List screen appears,
repeat the procedures outlined in SELECTING OCCUPATIONS SERIES and
SELECTING DUTIES.

Save & Quit. The Save and Quit option allows users to save their work up to this
point under the CD Name that was established at the beginning of the creation
process.

Abandon. This button allows users to exit without saving any of their work. The CD
Name assigned at the beginning of the creation process will not appear in their core
document folder. The application will display a confirmation message screen that
asks, “ Are you sure you want to abandon your current duty input?”. Click the “Yes”
button, to return the Main Menu screen. Click the “No” button and the application
will return the user to Figure 4-8.

Previous. This option allows users to return to the Duty List screen. Click the
“Prev” button to select additional duties.
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Click the “Continue” button and the application will display the Supplementary
Requirements Screen.

Selecting Supplemental Information

Users can elect to continue creating their core document by clicking the “Continue”
button. Users should now be in the Supplementary List screen shown in Figure 4-10.
This screen provides a list of standard supplemental requirements that can be selected for
a core document. Although these requirements should not effect the title, series or grade
of the position, they may be important in ensuring that the requirements for the position
are complete. Some examples of supplemental requirements include security clearance,
travel, shift work, overtime, and government licensing.

Core Document Development System - Supplementary List

Occupational Series Henu List

A | LB |LB Supplemental Information Library

Supplenentary List

Security clearance
Travel - frequency
Travel - mode

Shift wrork

Overtime

Other than normal hours

[ =
R T TS S S S

Overtime - emergency

Continue |

Count: *1

Figure 4-10. Supplementary List Screen

Users can select a particular option from the supplemental requirements by clicking the
corresponding check box. Move up and down with [Up/Down arrow] keys. It is not
necessary to use every requirement selected in this screen. During the next phase of the
selection process (Figure 4-11), users will go through a more comprehensive evaluation
to determine which ones will appear in the core document.
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When users click any of the check boxes in the Supplementary List screen, a screen
appears describing the Supplementary Requirements as shown in Figure 4-11.

= Core Document Development System - Supplementary List
SUPPLEHEHTARY SELECTION:

Click Check Box to select/funselect items. Press the Continue Button to continue without
zelection an iten, For additional help, click the HELP Button,

Security clearance

Select Classification

! 1 Secunty clearance
r‘

Secret clearance
Top Secret clearance

Description

Security clearance

Continue | Previous | Infurmatjun|

Figure 4-11. Supplementary List, Screen Two Screen

The Supplementary List screen has the following control buttons:

e Continue. This option allows users to proceed to the Percentages of Time screen.

* Previous. This option allows users to select additional supplementary duties.

* Information. This option allows users to obtain information about the screen.

This is the last phase of the supplemental requirements selection process. The
Supplementary Selection screen lists each selected requirement individually. The screen
shows the requirement along with a brief description of information on this screen. After

selecting all the supplementary duties from the list, click the “Continue” button. The
application will then display Figure 4-12.
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= Core Document Development System - Supplementary List

Select one of the following options by clicking on the button

Takes you to the next step in this process.

Save & QUitI Saves everything you did so far and returns you to the main menu,
Abandon I Hipes out what you did up to now and returns you to the main nenu,

m Takes you back to the same nenu,

Figure 4-12. Supplementary List, Continued

The Supplementary Selection screen has the following control buttons:

Continue. This option allows users to continue the core document creation process.

Save & Quit. This option allows users to save the work up to this point under the
CD Name that was established at the beginning of the creation process.

Abandon. Clicking this button allows users to exit without saving any of their work.
The CD Name assigned at the beginning of the creation process will not appear in
their core document folder. The application will display a confirmation message
screen that asks, *“ Are you sure you want to abandon your current duty input?”. Click
the “Yes” button, to return the Main Menu screen. Clicking the “No” button will
allow return the user to Figure 4-8.

Previous.  This option allows users to return to the preceding Supplementary
Selection screen.

To make selections from the Supplementary Selection screen click the check boxes.
Users can scroll up and down using scroll bars.

If the user clicks the “Continue” button from the supplementary list screen (Figure 4-12)
without making a selection, a message screen will appear asking the user, “Are you
finished with Supplementary Information?” screen. To continue the creation process
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without making a selection, select the “Yes” button with the mouse. The application will
then display the Percentages of Time screen. Select “No” to return to the Supplementary
List screen.

After selecting the last supplementary requirements, click the “Continue” button. The
application will display the Percentages of Time screen shown in Figure 4-13.

« NOTE: When creating a wage grade position, the Percentages of Time screen will
not appear until the user activates the setting for PERCENTAGE OF FWS POSITIONS
in the System Defaults screen (for more information, see chapter three of this guide).

= Percentages of Time

3 Duty

£ Pans and Designs Facilities Projects
Manages and Monitors Facilities Projects

I

B
B Manages and Monitors Facilities Projects
C Program Planning and Development

|

Total Percentage: 100 ¥

Continue |

Figure 4-13. Percentage of Time Screen

COREDOC 4-14



Chapter Four: Creating a Core Document

Assigning Percentages And Duty Criteria

The Percentages of Time screen lists the duties users have selected with an assigned
percent for each one. The COREDOC software automatically distributes percentages to
equal a total of 100%. They can easily change these percentages by typing in new
numbers to replace those assigned by the COREDOC system.

Three of the System defaults established under the Main Menu Utility function will be
displayed; CRITICAL or NONCRITICAL, PERCENTAGE OF FWS POSITIONS
settings, and AGENCY designator. These defaults affect how some of the items appear
on this screen and how the software operates. Use the arrow keys to change the
percentages.

If the CRITICAL/NONCRITICAL setting is selected, a column appears between
percentage and duty. The software automatically indicates that all duties are critical by
assigning “C” in the column headed “C” (for criticality). To change a duty to
noncritical, press the [Down Arrow] key to move the blinking cursor to the appropriate
entry in the “C” column. Using the [Delete] key, remove the letter “C”, then TYPE the
letter ""N™".

Percentages will appear for all general schedule positions and for wage grade only if the
PERCENTAGE OF FWS POSITIONS setting was selected as the System Default. The
agency designated within System Defaults screen will determine how the software allows
users to make changes to the percentages. To change a percentage, the blinking cursor
will appear in the square selected. Use the [Down Arrow] key to move the cursor to the
various percentage options, then enter the new percentage number.

As users change the percentages, the total percentage at the bottom of the screen will
fluctuate accordingly. When they have completed all their changes, press the down
[Down Arrow] key again. Click the “Continue” button. The application screen will then
display the Knowledge, Skills and Abilities screen (Figure 4-14).

If the Agency designator is the Air Force or Army, the application will not accept
percentages unless the total equals 100%. This is where the difference in agency
designator will become apparent. All others will be accepted only if the percentage range
is between 90 and 100 percent. A message will appear on screen if the percentages are
less than or greater than the total allowed.
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Selecting Staffing Knowledge, Skills and Abilities

Core Document Development System - Staffing KSAs

KSA Conpetency Identified in Position % of Tine

I Editing Written Communications 40
| Office Automation 20

J I TypingfKeyhoarding 20
_| HanfOrganize 60

| Interpret Regulations 20

J/ - Oral Communication 20

Description

fibility to prepare andfor edit written correspondence, ensuring proper use of
English gramnar, spelling and punctuation

Continue |

Menu Mode = Newr
Count: 6 v

Figure 4-14. Staffing KSAs Screen

This is the next step in the core document creation process. Users can select the
knowledge, skills, and abilities to be used for recruitment (staffing).

The team of facilitators and subject matter experts who developed the occupational data
in COREDOC have predetermined the knowledge, skills, and abilities needed for basic
training competencies for each duty statement.

The screen has the following columns - KSA, Competency Identified in Position, and %
of Time. The KSA column will usually be blank. If there are check marks already in the
column, the team of experts assembled to develop the occupational data considered the
knowledge, skills, and abilities in the adjacent column to be essential to both staffing and
training.

The numbers in the % of Time column indicate the percentage of work requiring the

particular competency (knowledge, skill or ability). For example, if the competency
applies to all of the duties selected then the percentage is 100.0. If the competency
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applies to only one duty and that duty comprises 30% of the job then the % of Time will
be 30.0. This column is displayed merely as additional information to assist users in
deciding which knowledge, skills, and abilities should be selected for staffing.

All of the competencies listed here will appear in the core document and in the Basic
Training Competencies section. Only those selected for staffing, however, will be listed
in the Selected Staffing KSAs section. To select the staffing knowledge, skills, and
abilities, use the [Arrow] keys to navigate between the check boxes. When the
appropriate competency is highlighted, click the checkbox using the mouse.

After the last selection is made, click the “Continue” button. The application will then
display the Core Document (Title, Pay Play, Series, and Grade) Summary screen (Figure
4-15).

Core Document Development System - Title, Pay Plan, Series, Grade

CD Hane: THPOO327
Official Title: Secretary {Typing}
Series: 0318

Pay Plan: G5
Grade; i:4
Fitia I Enntinud

Count: *1

Figure 4-15. Core Document (Title, Pay Plan, Series, and Grade) Summary Screen

The Core Document Summary screen contains the CD name, official title, series, pay
plan, and grade for the core document generated by the user (Figure 4-15). Figure 4-15
shows the title, series, and grade for CD Name TMP00327. There are three buttons
located at the bottom of the screen, “Edit”, “Title”, and “Continue”. The “Title” button is
“grayed out” during this phase of the creation process. Users may edit the official title,
series or pay plan for the core document. However, any changes made on this screen will
be reflected in the Classification Summary for the Core Document. Users may proceed
with the creation process by clicking the “Continue” button.
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Goals And Purpose Requirements

The first option under the Core Document Edit menu is Goals and Purpose. Select this
option by clicking it. A new screen will appear entitled Core Document (Goals and
Purpose). There are three buttons listed at the bottom of this menu, “Edit”, “Standard
Goals”, and Exit. To edit any of the information on this screen, click the “Edit” button
and place the cursor in one of the blocks.

An Organization’s Name and its Goals will automatically appear in the appropriate
blocks on the Core Document Goals and Purpose screen when users click the “Standard
Goals” button. Users can use the “Exit” button to return to the edit screen.

Use the mouse to move between the different sections on the screen. Users should notice
the location of the blinking cursor before they begin modifying the information on this
screen.

Core Document Development System - Goals and Purpose

CO Hane: TMPOD3Z7
Title: Secretary (Typing)
Organization:
Connents:

Organization Goals:

Purpose:

The secretary serves as the principal office assistant perforning administrative
and clerical duties in support of the work of a small or medium size organization,
where the required coordination is primarily internal to the organization,

Edit | Standard Goals | Cuntinue|
Count: *0

Figure 4-16. Core Document (Goals and Purpose) Screen

Users may proceed with the creation process by clicking the “Continue” button.
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Establishing Performance Standards

COREDOC is programmed to reconfigure the duties that are selected into objectives for
use in the Specific Performance Requirements screen. The COREDOC software will
format the duty statements (objectives) to emulate the users current performance
management plan. The Performance Management Plan screen is essentially identical for
each user. However, the output will be different depending on the user’s Agency.

Core Document Development System - Performance Management Plan

CD Hane: TMPOO3Z7
Title: Secretary (Typing)
Specific Elements and Standards:

Edit | fpis Duties | Cuntjnuel
Menu Mode = New
Count: *1

Figure 4-17. Performance Requirements Screen

To insert Specific Performance Requirements use the control buttons at the bottom of the
screen by clicking with the mouse:

» Edit. This option allows users to add text or change text to comply with their
agency's regulations governing performance elements and standards.

» Delete. This option allows users to remove text from the screen.

* Duties. This option allows users to load duty statements associated with the core
document onto the Performance Requirement Screen.

» Continue. This option allows users to continue the creation process.
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To establish performance elements and standards, click the “Duties” button. The
application will then display a message asking, “ Are you sure you want standards?”.
Click the “Yes” button. After the user selects the “Edit” option, the application will
display a brief description of the Performance Requirements. To accept these without
change, click the “Continue” button. Users can click the “Edit” button and make the
necessary changes.

«/ NOTE: In order for the Performance Management Plan (PMP) to appear in a core
document, users must either type specific text into the PMP screen or select Standard
Performance Requirements. Editing the Specific Performance Requirements screen
triggers the software to include the plan when viewing and printing a core document.

This is the last step in the creation process. Click the “Continue” button. After users

have completed generating a core document, the COREDOC system will automatically
take users to the Core Document Edit Menu (Figure 4-18).

Core Document Edit Menu

Core Document Development System

Edit  View Reports Ulility Quit

CD Hane: THPOO327
Organization:
Connentsy
Official Title: Secretary {Typing}
Pay Plan: G5 Series: 0318 Grade: 04  Agency: DD

CLASSIFIER - Default Agency = DD
Count: *1

Figure 4-18. Core Document Summary Screen
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The Core Document Edit Menu is used to view, edit, and print the core document. If the
user wishes to edit an existing core document at a later date, the user must return to the
Core Document Main Menu and select the “Open” option from the “File” menu under the
Core Document Menu Bar.
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CHAPTER FIVE: EDITING AN EXISTING CORE DOCUMENT

General 5-2

Modifying an Existing Core Document 5-2
Edit Goals and Purpose
Edit Major Duties
Modify Percentages of Assigned Duties
Edit Knowledge Factors
Edit Other Classification Factors
Edit KSAs and Training Competencies
Select Staffing KSAs
Select Other Work Requirements
Edit Cover Sheet
Edit Performance Requirements
Edit Title, Pay Plan and Series
Edit Cover Sheet
Edit Classification Remarks

Adding More Occupations 5-34
Classification Summary 5-35
Assigning a Position Number 5-35
View Menu 5-40
Report Menu 5-40
Utility Menu 5-40
Exit 5-41
Help Menu 5-41

This chapter describes how to view, edit, and print a core document that was previously
created. This chapter applies to any user having access to the COREDOC system.
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General

After users have completed generating a core document, the COREDOC system will
automatically take users to the Core Document Edit Menu. The Core Document Edit
Menu is used to view, edit, and print the core document. If the user wishes to edit an
existing core document at a later date, the user must return to the Core Document Main
Menu and select the “Open” option from the “File” menu under the Core Document
Menu Bar.

Modifying an Existing Core Document

After users have selected the “Open” option from the “File” menu, the application will
display the “Core Document Selection” screen shown in Figure 5-1.

The Core Document Selection screen contains three buttons, “CDs w/CPCNs”, “My
CDs”, and “Cancel”. If the user has never created a core document, the “CDs w/CPCNs”
and the “Cancel” buttons will be activated. Once the user has linked a core document
with a Request for Personnel Action (SF-52) in the PERSACTION system, all three
buttons will be activated. Click the “Cancel” button to return to the Core Document Edit
Menu.

« Note: If the user has previously created core documents, but never linked one to
personnel action request, the “Core Document Selection” screen will be by-passed. The
application will automatically display the “Available Core Documents” Screen shown in
Figure 5-2.

Core Document Selection

to select fron?

9 Hhich Core Docunents do you want

CDs w/CPCHs| Hy CDs| Cancel

Figure 5-1. Core Document Selection Screen

For illustration purposes, the user selected “My CDs” from the Core Document Selection
screen (Figure 5-1). The application will now display the Available Core Document
screen. This screen contains a listing of all the core documents generated by an
individual user.
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= Available Core Documents
Find |Thﬂmn%

CD Name fali] PP Srs Gr Title

MPO0120 AF Ga 0203 15 Personnel Clerk A |
TMPO0326 DD GS 0318 04 Secretary (Typing)
TMP00327 DD GS 0318 04 Secretary (Typing)

¥

= I =

Find oK | Cancel |

Figure 5-2. Available Core Documents Screen

This screen contains core documents that are listed in numerical order. To view the entire
list, scroll through the core documents or use the “Find” feature to locate the core
document that will be modified. Click the horizontal scroll bar to view the entire title for
a position. Highlight the core document and click the “OK” button, which then displays
the core document summary sheet.

Using the “Find” Feature. To use the “Find” feature, move the screen pointer to the
“Find” block located at the top of the dialog box. The cursor should be placed to the left
side of the percentage (%) symbol, then type part or all of the “CD Name” into the block.

For example, users can locate a core document with the name of “TMP000031 by
entering “T” before the % symbol. The application then narrows the list of selections to
those containing a “CD Name” beginning with the letter “T”. To execute the “Find”
option, press the [Enter] key or click the “Find” command button. When the desired
name is located, highlight the selection and then click the “OK” button.

After a core document is selected, the screen for the Core Document Main Edit screen is
displayed (Figure 5-3).

Some of the functions shown in the Figure 5-3 are also available from the COREDOC
Main Menu screen, such as printing a core document and changing its appearance by
modifying the system default designations. Users can modify almost every field in a core
document, except those fields determined by their Agencies (Components) to be non-
editable such as generic performance criteria.
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Core Document Development System

Edit View Reports Utility Quit

CD Hane: THPOO3Z?
Organization: Defense Agency
Connents;
Official Title: Secretary {(Typing}
Pay Plan: G5 Series: 0318 Grade: 04 Agency: DD

CLASSIFIER - Default Agency = DD
Count: *1

Figure 5-3. Core Document Development System Edit Screen

The Core Document Development System Edit screen contains six options within its
menu bar. These six options are:

e Edit. This option allows users to add, delete, or modify any part of the core
document.

* View. This option allows users to view any part of the core document. This option is
available to all users.

* Reports. This option allows users to create a variety of special output products to
the printer or a file.

» Utility. The option allows users to configure software to specific requirements.

e Quit. Selecting this option will return the user to the Core Document Main Menu
screen.

e Help. This option allow users to view an on-line tutorial.

The Edit Menu. Click the “Edit” option to activate a drop down menu that contains
fifteen individual options. Additionally, the “Performance Management” option may be
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“grayed-out” for managers and personnelists based on an agency’s internal performance
management directives.

Goals and Purpose

Major Duties

Percentages

Knowledge Factors
Other Factors

KS5As (Competencies)
Select Staffing KSAs
Other Work Requirements
Performance Management Plan
TitlefPay FlanfSeries
Covey Sheal
Classification Remarks
More Occupations

Classification Summary

Exit

Figure 5-4. Edit Menu Screen

The Edit Menu has the following options:

Goals and Purpose. This option allows users to change the Organizational Goals,
Name and Purpose of Position for an existing core document

Major Duties. This option allows users to modify duties and tasks in an existing core
document.

Percentages. This option allows users to change the percentages of time assigned for
each duty in an existing core document.

Knowledge Factors. This option allows users to edit the classification knowledge
factors for an existing core document.

Other Facts. This option allows users to edit the other classification factors for an
existing core document.

KSAs (Competencies). This option allows users to add, delete or modify the basic
knowledge, skills and abilities for an existing core document.

Select staffing KSAs. This option allows users to select or deselect previously
selected staffing (requirement) knowledge, skills and abilities in an existing core
document.

Other Work Requirements. Allows users to modify, add, delete supplementary
duties and responsibilities for an existing core document.
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* Performance Management. Allows users to add, delete, or modify performance
elements and standards for an existing core document. Additionally, a agency-
specific Performance Management Plan screen will be displayed when the core
document has been assigned a Civilian Position Control Number.

» Title/Pay Plan/Series. Allows users to change title, series and/or pay plan for an
existing core document.

e Cover Sheet. This option allows supervisory and managers during the creation
process to complete and sign a core document cover sheet. The Cover Sheet option
will be activated under both the “Edit” and “Reports” menus when the CD has been
assigned a Civilian Position Control Number.

e Classification Remarks. Allows users to add remarks to supplement the summary
information for an existing core document.

* More Occupations. Allows users to add duties from a different occupational series
to an existing core document.

» Classification Summary. Allows users to view the classification summary for an
existing core document.

» Exit. Allows users to quit out of “Edit” mode and return to the Core Document Main
Menu screen.

Edit Goals And Purpose Requirements

The first option under the Edit Menu is Goals and Purpose. Select this option by clicking
it. The Goals and Purpose Screen contains the CD Name, Title, Organization,
Comments, Organizational Goals, and Purpose. There are three buttons listed at the
bottom of this menu, “Edit”, “Standard Goals”, and “Exit”.

An Organization’s Name and its Goals will automatically appear in the appropriate

blocks on the Core Document Goals and Purpose screen when users click the “Standard
Goals” button.
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Core Document Development System - Goals and Purpose

CO Hane: TMPOD3Z7
Title: Secretary (Typing)
Organization: Defense Agency
Connents:

Organization Goals:

Purpose:

The secretary serves as the principal office assistant perforning administrative
and clerical duties in support of the work of a small or medium size organization,
where the required coordination is primarily internal to the organization,

Edit | Standard Goals I Exit |

Menu Mode = Edit
Count: *0

Figure 5-5. Core Document (Goals and Purpose) Screen

Use the mouse or the [Tab] key to navigate between the different sections on the screen.
To edit any of the information on this screen, place the cursor in one of the blocks, and
click the “Edit” button that located at the bottom of the screen. The application will then
change the “Edit” button into a “Save” button. After the last modification is made, click
the “Save” button. Click the “Continue” button to return to the Core Document Edit

Menu (Figure 5-3).
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Edit Major Duties

The second option on the Core Document Edit Menu under the “Edit” option is entitled
“Major Duties”.

= CORE DOCUMENT TMPO0327 [VWork Objectives)
2.01
CD Hunber: TMPOD327 Title: Secretary (Typing)

Duty 4 1 of 4
Duty Hame: Prepares correspondence, reports, eic

Lewvel 1 {of 4)

L

[Prepares correspondence, reports, and other documents.

Lo Al

1. Accurately types correspondence, reports, or similar materials from handwritten drafts using a
typewriter.

Z. Ensures correct grammar, spelling, capitalization, punctuation, and appropriate format.

|

Edit | fwsvious | Mext | add | Delete |  Relation | Exit |

Figure 5-6. Core Document TMP00327 (work objectives) Screen

Figure 5-6 displays the CD Number, Title, Duty Number, Duty Name, Level and Tasks
for first duty statement, “Prepares Correspondence, Reports, etc.” for Core Document
Number TMP00327.

The "Core Document (Work Objectives)" screen appears with seven control buttons
displayed across the bottom of this screen: These buttons are:

» Edit. The Edit button allows users to edit the displayed duty.

* Next. When activated, this button allows users to view the next duty statement.

* Previous. When activated, this button allows users to view the previous duty
statement.

* Add. This option allows users to add a new duty statement from the library. If the
user has previously selected all the available duties for the occupational series, the
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application will display a blank screen. The user can then enter the duty name and a
description into the text box.

» Delete. The option allows users to delete the current duty statement.

* Relation. Clicking this button, allows users to understand the connections between
individual duty statements and the classification knowledge and training
competencies.

» Exit. Clicking this button allows users to return to the Core Document Edit Menu.

The CD Number and the Title of the Position are located at the top of the screen. This
screen also displays the current duty number, how many duties exist, and the name of the
duty. Immediately below the Duty Name, there are two text boxes. The first text box
contains the entire duty statement. The second text box contains the task or objective for
that duty statement (i.e. what work is done).

If more than one level is available for a duty statement, click the “Edit” button and the
application will display the “Edit Options” dialog box shown in Figure 5-6. The “Edit
Options” dialog box allows users to select one of the three options, “Current Text”,
“Library Text”, or “Cancel Edit request”. Click the check box to select any of the
options.

Current Texi Hake nodifications to the duty®s current text data

Chooze another level for the current duty

Lib Text - 3 i
ibrary lex fron the Occupational Series Henu Library

Cancel Edit reques Return to previous screen

Figure 5-7. Edit Options Dialog Box
Edit Current Text

The “Edit Current Text” option allows users to modify the current text on the screen. To
edit any of these sections, users must first place the screen pointer into one of the text
boxes. To change any of the text, delete the current text and type the new text in its
place. Users may also type additional text as desired. The blinking cursor will indicate
the current section to be edited.

When users begin editing text, the cursor is in the "Duty Name" field. Using the mouse,

go to the section immediately below the “Duty Name” field. This is the field for the duty
statement. Immediately below this is the field for the various tasks. Users can view all of
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the tasks (duty statements) contained in this field by using the scroll bar located on the
right-hand side of the screen.

To modify the text in the “Duty” or “Task” field, click the “Edit” button, the application
will display the entire duty statement. For illustration, Figure 5-8 contains the “Duty
Statement for Level 1, Secretary (Typing), GS-0318-04".

Duty Statement for Level 1. Secretary [Typing] G5-0318-04

Duty Statenent Returm |

Prepares correspondence, reports, and other documents.

~L L

Ifl. Acoorately types correspondence, reports, or stoalar materials from _\
handwritten drafts using a typeswter.

2. Ensures correct grammar, spelling, capitalization, punctuation, and
appropriate format.

|

Figure 5-8. Edit Option - Current Duty Statement Text Screen

The application automatically places the cursor into the text box. Use the [Arrow] keys
or the scroll bar to navigate through the text box. Once a duty is located, use the
[backspace] or the [delete] key to remove the unwanted text, then type the new text. If
users want to add a new work objective to the “Duty” section, move the cursor to the last
task and begin typing.

If users are in the Duty section and want to move to the “Tasks” text box, users must use
the mouse to place the screen pointer in the “Tasks” section of the screen. They will now
see the blinking cursor in the “Tasks” section. Use the scroll bar or the [Arrow] keys to
navigate through the contents of the “Task” section. To add a new work objective to the
“task”, move the cursor to the last task and begin typing. To move the cursor back to the
“Duty” section of the Work Objective screen, press the [Page Up] key. Users should note
that the blinking cursor has moved to the previous section.
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After the last change is made, click the “Return” box located at the top right-hand corner
of the screen. The application will then return the user to Core Document Work
Objective (Figure 5-6) screen.

Edit Library Text

The Edit Library Text option allows users to view the individual duties from the
occupational series previous selected. To select a new duty level, click the checkbox next
to the desired level. The application will automatically display a description of the level
selected.

Click the “Statement” button to view additional information concerning a new duty
statement from the Core Document Library. Clicking the “Cancel” button will reinstate
the previously selected work objectives without re-establishing the duty.

GS - 0318 Secretary - SmallMedium Off. Cl. Levels for Duty A. Prepares corre

Return to Hork
DUTY LEYEL SELECTION: . . i q
Click with the nmouse on the l]h,jectlues_ult,hnut Display Duty
checkbox for desired level re-establishing Statenent
the duty

Cancel | Statement |

Level Clazsification

Z  Secretary G5-0318-04
3 Secretary G5-0318-05
4 Secretary G5-0318-05

T o

Level 2 Description

iIn addition to the previous option, position requires knowledge of word processing software A
and related computer systems. (Typical of GS-4)

~.

Figure 5-9 Edit Options - Library Text Screen
Cancel Edit Request

Clicking the “Cancel Edit Request” button on the “Edit Options” dialog box will return
users to the Edit Work Objectives screen (see Figure 5-6).
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Relationship

The identification of knowledge requirements is crucial to the classification and staffing
process whether the classification standards are in the Factor Evaluation System (FES) or
the narrative format. To review these requirements, type the letter "R™ to display the
Relation screens.

Figure 5-10 shows the “Related Competencies KSA” screen which displays a list of
competencies associated with a selected duty statement. The subject matter experts who
developed the requirements for the COREDOC system determined that training
competencies are important to the staffing process. The subject matter experts identified
a list of knowledges, skills, and abilities that are crucial to successful performance of an
occupation. However, users can select additional competencies for a duty statement.
Clicking the checkbox adjacent to the duty name will select it. Additionally, clicking the
checkbox will deselect an option already marked. Click the “Exit” button to return to the
Major Duties (Work Objective) Screen (Figure 5-6).

= Related Competencies [K5A's]

Duty Mame: Prepares comespondence, reports, etc

Select / Unselect Conmpetencies Dotinaie | Exit |
to relate to the current duty,
Yy to related back to Hork

Select Conpetency Title Knowledges Db jectives
IE Editing Written Communications
Typing/Keyhoarding
Flan{Organize
Oral Communication
Interpret Regulations
Ahility to advise others

[N SN TS S S N S

Description

Ability to prepare andlor edit witten correspondence, ensurng proper nse of Enghish grarmear, spelling and A
punctuation

~

Figure 5-10. Relations Screen - Related Competencies (KSAs) Screen
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If the user has modified the duty statement, the “Continue” button will be activated.
Clicking the “Continue” button on the “Related Competencies (KSAs) screen allows
users to view a list of related knowledges for a duty statement (Figure 5-11). However,
users can not edit the knowledge statements associated with a duty statement from the
“Related Knowledges” Screen. Clicking the checkbox next to a “Knowledge Title” will
allow users to view a detailed description in the text box.

= Related Knowledges
Duty Hane: Travel Arrangements
Continue |

Select Knowledge Title Level
I = [[I(nuwledge of duties, priorities and commitments (Work Sit. B)
o knowledge of typewnters and/or word processors
- knowledge of office automation software
1 Knowledge to advise and train other staff in office procedures

T— S

[ N S S

{
Description

:The secretary serves as the principal administrative support position in an
organization of moderate size and complexity. The supervisor directs the staff
through intermediate supervisors. The subordinate groups differ in such aspects
as subject matter, functions, relationships with other organizations, and
administrative demands in such ways as to place significant demands on the
secretary position. The position requires the following knowledges:

- Knowledge of the duties, priorities, commitments, policies, and program goals
of the staff sufficient to perform assignments such as reviewing publications,
directives, and other matetrials which may affect the division and taking
appropriate follow -up actions; and to anticipate and prepare materials the i

Figure 5-11. Related Knowledges Screen

Click the “Continue” button to return to the Core Document (Work Objectives) menu
(Figure 5-6).

The “Core Document (Work Objectives) menu contains five other options, “Previous”,
“Next”, “Add”, “Delete”, and “Exit”. If users want to see the Next or remaining list of
duties, continue clicking the “Next” button until all of the duty statements have been
viewed. The “Next” button is automatically disabled when there are no additional duties.
If users have added or deleted a duty, the application will take the user to the Percentages
screen. Otherwise, users will be returned to the Edit Menu Screen (Figure 5-4).
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Modify Percentages Of Assigned Duties

This is the third option under the “Edit” menu within the Core Document Edit Menu.
This option allows users to modify the percentages for each of the assigned duties.

Percentages of Time

£ CD Grade Duty

I 04 Frepares correspondence, reports, etc
£3 04 Maintains calendars and schedules
£5 04 Receives and screens calls and visitors
£3 04 Travel arrangements

EL

Total Percentage; 100 X

Continue |

Count: *4

Figure 5-12. Percentages of Time Screen

Click the “Percentages” option and the application will display the Percentages of Time
screen (Figure 5-12). This screen displays a list of the duties that have been selected for a
core document. The screen also displays the percentages of time spent performing each
duty or work objective. The total percentage for all the position duties is shown at the
bottom of the screen. Generally, the final total must be 100 percent. However,
depending on the user’s classification policy, the percentage may fall within a range of 90
to 100. If the user’s organization permits a total of less than 100 percent, and the total is
between 90 and 100 percent, the system will automatically generate an additional duty
entitled "Performs Other Duties As Assigned".

Use the [Arrow] keys or the mouse to move the cursor to the desired duty statement. To
change a percentage of any duty, move the cursor to the field and enter the new number.
The block at the bottom of this screen entitled "Total Percentage” will show the total
percentage after each revision. A maximum of two numbers can be entered on the
percentage line for any duty listed. Therefore, if a percentage of 100 or more is assigned
to any duty statement, the system will prevent the user from leaving this menu.
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Additionally, the application will display a warning message that the total percentage
must be 100 percent or between 90 and 100 percent, depending on the organizational
component. Users will be returned to the “Modify Percentages” screen until the total
percentage is in compliance with their agency requirements.

If the CRITICAL/NONCRITICAL setting was selected, a column appears between
percentage and duty. The software automatically indicates that all duties are critical by
assigning “C” in the column headed C (for criticality). To change a duty to non-critical:
press the [Tab] key or move the blinking cursor to the appropriate entry in the “C”
column then type the letter "N". Click the “Continue” button to return to the Core
Document Edit Menu.

Edit Knowledge Factor

The “Edit Knowledge Factor” option shows the classification knowledge requirements
that were automatically assigned based on the duties selected by the user. Upon selection
of this option, a menu will appear on the screen entitled "Core Document (Classification
Knowledge Factors)".

CORE DOCUMENT <Classification Knowledqge Factors>
CO HAHE: THMPOO327 Yersion 2,01
TITLE:  Secretary (Typing)
kEnowledge Factor # Iz_ oF |4_ Level : |_3 Points : 350
- Knowledge of standard office equipment such as typewrnters, copiers, fax machines, etc., to A
perfonm routine clerical and administrative functions. Limited knowledge of PCs and software
such as word processors, graphics, spreadsheets, database management systems, and
communications.
£
Edit | Previous Hext Add Delete | Level Exit |
Count: 2 oy

Figure 5-13. Core Document - Classification Knowledge Factors Screen
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The Core Document, Classification Knowledge Factors screen contains seven buttons.
These buttons are:

» Edit. The Edit button allows users to edit the classification knowledge factor.

* Next. When activated, this button allows users to view the next duty knowledge
factor.

* Previous. When activated, this button allows users to view the previous knowledge
factor.

* Add. This option allows users to add a new knowledge factor.
» Delete. This option allows users to delete the current knowledge factor.

* Level. This option allows users to change the classification level of a new or
modified knowledge factor.

» Exit. This options allows user to return to Core Document Edit Menu

To edit the information, click the “Edit” button. Use the [Page Up/Page Down] keys or
the [Arrow] keys to move the cursor to the desired location. After users have finished
editing, click the “End” button which now appears at the bottom of the screen. This will
take users back to the “Knowledge Factors” Screen.

To add a new knowledge factor, click the “Add” button. The application will then create
a new record and append it to the end of the knowledge factors section. Users can make
changes to the actual text displayed. After users have completed entering their
information, click the “End” button to continue to the next step in the process.

If users add a new classification knowledge or edit a current knowledge requirement, the
application will display the different classification levels for that knowledge (Figure 5-
14). We recommend that users contact a subject matter expert in the Civilian Human
Resources Office for guidance on the proper determination of a classification level if they
are unfamiliar with a classification standard.
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bl Knowledge Factor Level
Find I%

Level Poinis

200
350
550
750
950

1250

1550

1850 =

= =]

Find oK | Can-::ell

MO =l h LM

Figure 5-14. Knowledge Factor Level Screen

Using the scroll bars or the “Find” feature, locate the desired knowledge factor level, then
click the “OK” button.

The application will then display a message that states: “Do you want to Link it to a Duty
in order to display it in the Core Document”. Click the “Yes” button. The application
will display the “Link Knowledge Factor to Duties” dialog box shown in Figure 5-15).

= Link Knowledge Factor to Duties
Related Duties Level ¥ of Tine
I -1 Screens calls and visitors 1 15
Travel Arrangements s 3o
| Use office automation softvwrare Z 30
-1 Advisesfirains staff on office procedures 1 20
o
o
o
Tl F
Solent A8 Continue | Exit |

Figure 5-15. Link Knowledge Factor to Duties Dialog Box

To select a related duty, click one of the check boxes adjacent to a duty name. Users may
elect to link the new knowledge factor with all of the duty statements by clicking the
“Select All” option. Click the “Continue” button to return to the knowledge factors
screen.
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The Knowledge Factors screen contains several additional options, “Next”, “Previous”,
“Delete”, and “Exit”. If users select the “Next” option, any necessary editorial changes to
the other classification knowledge requirements can be made. They do not have to go
through all of the listed knowledge requirements before leaving this screen. Users can
end the edit process any time by clicking the “Exit” button.

Users can remove any information from a classification knowledge factor by clicking. the
“Delete” button. The application will then display a confirmation message. Click the
“Yes” button to delete the knowledge factor or the “No” button to cancel the delete
command.

' Caution: If users delete a classification knowledge, it could have an impact on the
classification of the position. The classification knowledge linked to the duties in the
occupational database were carefully reviewed and approved by subject matter experts
and personnel specialists throughout the Department of Defense.

Clicking the “Exit” button will return users to the Core Document Edit Menu.

Edit Other Classification Factors

In the Core Document Edit Menu, under the Edit option, click “Other Factors”. The
application will display the “Core Document (Other Factors)” screen shown in Figure 5-
16. This option allows users to edit classification factors two through nine under the
Factor Evaluation System (FES) for General Schedule positions and Factors Two through
Four in the Federal Wage System. Upon selection of the “Other Factors” option, the
application will display a screen that lists the factors in numerical order.
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COREDOC[Other Factors]

C'd Heme : TMPO0450

Tifle : Training Speciatist

|Factor 3: Guidelines |

Description:
‘Administrative policies and precedents are applicable, hut are stated in general texms. Guidelines for
performing the work arve scawrce or of linited use and the work frequently requires original
development and revision of materials or methods. The employee uses nitiative amd resowrcefulness
in deviating from traditional methods or researching trends amd patterns to develop new methods,
critexia, or proposed new policies.

Edit | Previous Next | Library | Exit

Count: 4 v zInsert=

Figure 5-16. Core Document - Other Factors Screen

The Core Document - Other Factors screen contains six command buttons.

Edit. This option allows users to edit a classification factor.
Next. When activated, this button allows users to view the next knowledge factor.

Previous. When activated, this button allows users to view the previous knowledge
factor.

Library. This option allows users to select other factor level options from the
occupational database library.

Exit. This option end the edit mode and returns users to the Core Document Edit
Menu.

End. This option is dimmed until the edit option is selected.

If users click the “Edit” button, a blinking cursor will appear on the screen. All the
buttons will be disabled and the “End” button will be activated. Use the [Arrow] keys or
mouse to move the cursor to a section of the text that will be modified. Users also have
the option to select other options, using the Library option.

If users edit the factor, a box is displayed that shows the different classification levels for
the factor. Users should refer to the classification standard for the subject occupation to
properly determine which level is appropriate based on their revisions. Clicking the
“End” button will permit users to discontinue any further text modifications and will
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display the “FACTLVL” dialog box shown in Figure 5-17. The “FACTLVL” dialog box
displays the different classification levels and the point assigned for each classification
factor.

= FACTLYL
Find Ia%

FACTOR LEVEL POINTS

-~ L-

=]

IA

Find OK | Cancel

Figure 5-17. Other Factors - Factor Level Dialog Box

Using the scroll bars or the “Find” feature, locate the desired classification factor level,
then click the “OK” button. The application will return users to the “Core Document
Other Factors” screen.

User can select classification factors from the occupational library within the COREDOC
system, by clicking the “Library” command button. The application will then display a
menu entitled "Library (Other Factors)" shown in Figure 5-18). These factor level
descriptions will vary depending on the occupation selected, factor level, and factor type.
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Library [Other Factors]

Factor 2: Supendzony Controls Dption Il

The supervisor provides distinct assignments that are accompamed by detailed and specific _\
instructons. The secretary works as instmcted and consults with the supendsor as needed on all
matters not specifically covered in the original instmetions.
Work is closely confrolled and reviewed. As the secretary leamns the routine processes and
procedures of the office, performs assigned dutes with greater independence.

/

Previnus' Hext | Select |

1
Count: 1 v

Figure 5-18. Library - Other Factors Screen

Click the “Select” button, to chose a description of a factor level. To see the next factor
level, click the “Next” button. To view the earlier factor level, click the “Previous”
button. Clicking the “Exit” button, allows users to return to the “Core Document (other
Factors)” screen (see Figure 5-16) without making any changes. To view other factor
levels, such as Factor 2: Supervisory Controls, users must return to the “Core Document
(Other Classification Factors)” screen. Click the “Exit” button to return to the Core
Document Edit Menu (Figure 5-4).

Edit KSAs (Competencies)

The next option on the Core Document Edit Menu, under the Edit option, is KSAs
(Competencies) screen. This screen shows the first of the training competencies that are
currently associated with the duties chosen by the user. This screen will also display the
KSA followed by the number of the current competency and the total number of
competencies linked to this core document. If the user has not previously edited this
section, the screen will display those competencies which were preselected by the
COREDOC system based upon the duties chosen.

COREDOC 5-21



Chapter Five: Editing a Core Document

CORE DOCUMENT <KSAs Competencies>

CD HARE:  TITLE: Yersion 2,01
TMPO0327 Secretary (Typing)

KsA ¢ [2° oF |8

[Anility 1o type; must be a qualified typist I

il

Edit | Previous | Mext | Add | Delete | Link | Exit |
Count: 2 "

Figure 5-19. Core Document (KSAs - Competencies) Screen

There are seven options available in this menu that are listed at the bottom of the screen:
» Edit. This option allows users to edit the displayed competency (KSA).
» Next. This option allows users to view the next competency (KSA).
* Previous. This option allows users to view the previous competency (KSA).
* Add. This option allows users to add a new competency (KSA).
» Delete. This option allows users to delete the current competency (KSA).

e Link. This option allows users to link one or more competencies to a duty
statement.

» Exit. This option allows users to return to Core Document Edit Menu

Users can make changes to the actual text displayed or go to the library and see the other
competencies (KSAs) which were available for the selected occupations. To access the
KSA Library, users must click the “Exit” button to exit this menu, then select the
“Staffing KSAs” option from the “Edit” menu. Instructions for selecting Staffing KSAs
are provided in the next section of this User Guide.
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Click the “Edit” button, to edit the KSA shown on the screen. Users will notice that all
the buttons at the bottom of the screen have disappeared, and a new button “End” now
appears. The COREDOC system assigns a number for each KSA that is a located above
the KSA text.

Use the [Arrow] keys or mouse to move the cursor. Make the necessary changes to the
text of this KSA and click the “End” button at the bottom of the screen to end this
process. To view another KSA, click the “Next” button. The next KSA will then appear
allowing users to make their desired modifications. Continue clicking the “Next” button,
to view the remaining KSAs.

To add another KSA, click the “Add” button, the application will then display a new Core
Document KSA screen. Clicking the “End” button will take users to the next step in the
process. A box will appear asking users, “Do you want to link it (KSA) to a duty in order
to display it in the Core Document?”.

= Oracle Forms

¢ Do you want to link it to duty in onder
= to display it in Core Document 7

YES NO |

Figure 5-20. Message Screen.

If users click the “No” button, the individual competency will not be linked, and they will
be returned to the CORE DOCUMENT (KSAs - Competencies) screen. If they select
“Yes”, anew menu will then appear entitled “Link KSA to Duties” (Figure 5-21).

To select a related duty, click one of the check boxes adjacent to a duty name. Users may

elect to link the new KSA (competency) with all of the duty statements by clicking the
“Select All” option.
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= Link KSA to Duties

Related Duties Lewvel # of Time
I Prepares correspondence, reports, etc 1 23

.1 Maintains calendars and schedules 1 23

-1 Receives and screens calls and visitors 1 Z2a

o Travel arrangements 1 23

o

o

o
ol |

et A Continue I

Figure 5-21. Link KSA to Duties Screen

Click the “Continue” button, to return to the Core Document (KSAs) menu and to the
next step in the process.

The “Core Document (KSAs - Competencies)” screen contains several additional options,
“Next”, “Previous”, “Delete”, and “Exit”. If users select the “Next” option, any
necessary editorial changes can be made to the other KSA requirements. Users do not
have to go through all of the listed KSAs requirements before they can exit. They can
end the edit process any time by clicking the “Exit” button.

Users can remove any information from “Core Document (KSAs - Competencies)”
screen by clicking the “Delete” button. The application will then display a confirmation
message. Click the “Yes” button to delete a KSAs (Competency) or the “No” button to
cancel the delete command. Clicking the “Exit” button will return users to the Core
Document Edit Menu (Figure 5-4).

Select Staffing KSAs

The seventh option on the Core Document Edit Menu, under the Edit option, is “Select
Staffing KSAs”. By clicking the “Select Staffing KSAs” option, the menu titled
"Knowledge, Skills, and Abilities” will appear on the user’s screen. Make the KSA
selections or deletions from the items listed in the column entitled "Competency
Identified in Position" by clicking the check boxes adjacent to it.

As users scroll through the KSAs, a description of these requirements will be shown in
greater detail in the section of this menu titled "Description”. Select the “Exit w/save”
option, to save the changes made on the screen. If users do not wish to save the changes
made on screen, click the “Exit w/o save”.
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Select Other Work Requirements

Users may add supplemental information to the core document that has no affect on the
classification but may be essential in filling the position. To add supplementary
information, select the eighth option entitled “Other Work Requirements” in the Core
Document Edit Menu under the Edit option. Some examples of supplementary
information would include the requirement to work overtime or shift work, security
clearances, or the need for frequent travel.

= Core Document Development System - Other Work Requirements

CO Hane: THMPOD3Z27

Title: Secretary (Typing)

Info # 1 of 1

The enployee nust obtain and naintain an appropriate security clearance.

Add | Delete | Library | Exit

Figure 5-22. Core Document - Supplementary Information Screen

The application will then display the "Core Document (Supplementary Information)".
Screen. There are seven options available in this menu and these are listed at the bottom
of the screen.

* Edit. This option allows users to edit any supplemental item.
* Next. This option allows users to view the next supplemental item.

* Previous. This option allows users to view the previous supplemental item.
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e Add. This option allows users to add a new supplemental item.
» Delete. This option allows users to delete the a supplemental item.

* Library. This option allows users to view a list of supplemental items for an
occupational series.

» Exit. This option allows users to end the edit mode and return to Core Document
Edit Menu

Clicking the “Edit” button allows users to modify the position requirement statements
found in this menu. The system assigns a number for that particular requirement and it is
located above the requirement description text. Users cannot edit this number since it is
assigned by the COREDOC system. Make the necessary changes to the text of this job
requirement then click the “End” button. The application will then end the edit process
and display the seven options at the bottom of the screen again.

The “Core Document (supplementary Information)” screen contains several additional
options, “Next”, “Previous”, “Delete”, and “Exit”. If users select the “Next” option, any
necessary editorial changes can be made to the other supplementary requirements. Users
can end the edit process any time by clicking the “Exit” button.

Users can add another supplementary requirement for a position, by clicking the “Add”
command button. After entering the supplementary requirements, click the “End” button
to return to the Core Document (Supplementary Information) menu. Users can make
changes to the actual text displayed or go to the library and see the other job requirements
which were available for the selected occupations.

Users can remove any supplementary information from a core document by clicking the
“Delete” button. The application will then display a confirmation message. Click the
“Yes” button to delete the knowledge factor or the “No” button to cancel the delete
command.

Edit Performance Requirements

The “Edit Performance Requirements” option allows users to modify a Performance
Management Plan. To edit a performance plan, click the ninth option under “Edit” menu
in the Core Document Edit Menu. This option allows users to add non-classification
information related to the performance appraisal process.
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Core Document Development System - Pedformance Management Plan

| -
|-

CD Hane: TMPODZ39
Title: Secretary
specific Elements and Standards:

Perfornance Objective 1:
Prepares correspondence, reports, and other documents.
Perfornance Objective 2%

Schedules neetings, appointments, and conferences in accordance with
instructions fromn supervisor,

Perfornance Objective 3:

Receives visitors and phone calls,

Edit | Delete | Dating | Exit |
Menu Mode = Edit
Count: *1

Figure 5-23. Performance Management Plan Screen

The CD Number and the Title of the Position appear at the top of the menu screen. Users
have four options from which to select on this screen, “Edit”, “Delete”, “Duties”, and
“Continue”. Click the “Duties” button to select the Standard Performance Requirements.
After selecting this option, the COREDOC system will automatically insert the Duty
(objective) summary statements from each of the duties that were selected. Users can add
or edit the information text displayed in this menu. There may be more than one
performance objective listed in this menu.

Click the “Edit” button to modify a performance element. Use the scroll bar to navigate
through the performance elements. Clicking the “Delete” button, will remove all of the
performance elements from the core document.
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Click the “Exit” button and the application will display either the Core Document Edit
Menu or an agency specific performance management plan screen. The Agency Specific
Performance Management Plan screen will be displayed, if a Civilian Position Control
Number was assigned to the core document.

For illustration purposes the Army Performance Management Plan screen is shown in
Figure 5-24.

Core Document Development System - Army Performance Information

CD Mane: TMPODZ93 Title: Secretary
Date Period: to Ratee: Unencumbered Position
Initialz: Hidpoint: Rater Chain
Rater:

Internediate {Optional}:

Initial Key Points: Senior:

Hidpoint Key Points:

Enployee’s Significant Contributions:

i
/
Edit | 3ave | (bnﬂﬁﬁe'

Count: *0
Figure 5-24. Army Performance Management Plan Screen

The Army Performance Management Plan screen contains several blocks, including the
CD Name, Title of the Position, Rating Periods, names of the first-level and second-level
supervisors, and three comment blocks. Users have three options from which to select on
this screen, “Edit”, “Save”, and “Continue”.

Click the “Edit” button to modify the information on the screen. To end the “edit”

function, click the “Save” button. Click the “Continue” button to return to the
COREDOC Edit Menu Screen.

COREDOC 5-28



Chapter Five: Editing a Core Document

Edit Title, Pay Plan, and Series

Select the tenth option on the Core Document Edit Menu under the “Edit” option to
modify the title, pay plan and series of the position. Users can select this option by
selecting it with the mouse.

A new menu will appear titled Core Document (Title, Pay Plan, Series and Grade). This
screen shows the title, pay plan, series, and grade that the COREDOC system
automatically generated. Users can not edit the grade of the position. Click the “Edit”
button to change the Title, Pay Plan or Occupational Series. Users can move to the next
item by using the [Tab] key.

Users may view the original list of title options appropriate for the duty list by clicking
the “Titles” button. Use the mouse to highlight a particular title.

== Available Titles

1.4
Title

% [contract Administrator |
Contract Negotiator

Contract PricefCost Analyst

Contract Tenmination Specialist

Procurement Analyst

Ll

Select | Infonmation | Ex=it |

Figure 5-25. Available Titles Screen
Click the “Information” button to see information about titling practices appropriate for

the position. Click the “Select” button to make the title selection. The Application will
then display the Core Document Summary screen.
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To change the grade, users must either change the duties or modify the classification
factors from the Duty, Classification Knowledge or Other Factors options. Click the
“Exit” button to end the edit process and return to the Core Document Edit Menu.
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Edit Cover Sheet

The “Edit Cover Sheet” option allows users to complete a Cover Sheet for a core
document. To edit the cover sheet, click the eleventh option under “Edit” menu in the
Core Document Edit Menu. Depending on the Agency Default, the application will
display either a generic or an agency specific cover sheet.

For illustration purposes, the cover sheet shown in Figures 5-26, 5-27, and 5-28 is
displayed for Air Force users.

Core Document - Cover Sheet Screen 1 of 3

Claszification: Safety and Occupational Health Specialist G5=-0018-12

Unofficial Title:|Safety and Occupational Health Specialist |

Enploy OFf Loc: Job Share: H
Duty Station: Emergency Ess: H
Target Grade: 12 Hobilization: M
Reason for Subnission: Sensitivity: Position is:

-+ Redescription “* Hon- Sensitive “* Supervisory

+«» Reestablishment +« Noncritical Sensitive ++ Managenal

A New - Critical Sensitive -+ Meither

« Other < Special Sensitive

Previous PD#:
Financial Statement{s) Required;

I Public Financial Disclosure Report
Inmediate Supervisor: I Confidential Financial Disclosure Report

Hane:
Title:

Higher Level Supervisor or Hanager/Reviewer:

Hane:
Title:
Help | Hext | Save | Exit |
Flease use TAE key to move to next field
Count: "0

Figure 5-26. Cover Sheet- Page 1
Page one of the Cover Sheet contains four buttons at the bottom of the screen.

» Help. This option allows user to access a table of values for a particular block on the
cover sheet.

* Next. When activated, this button allows users to view the next page of the cover
sheet.

e Save. This option allows users to save the information entered on the screen.

COREDOC 5-31



Chapter Five: Editing a Core Document

» Exit. Selecting this option will return the user to the Core Document Main Menu
screen.

Click the “Next” button. The application will then display page two of the cover sheet.

Core Document - Cover Sheet Screen 2 of 3

Classification: Safety and Dccupational Health Specialist G5S-0018-12

Organization: [AIR FORCE |

First Subdivision:
Second Subdivision:
Third Subdivision:
Fourth Subdivision:

Fifth Subdivizion:

Help | Prev | Hext | Save | Exit |

Flease use TAE key to move to next field.
Count: "0

Figure 5-27. Cover Sheet - Page 2

Click the “Next” button. The application will then display the last page of the cover
sheet.
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Core Document - Cover Sheet Screen 3 of 3

Classification: Secretary {(Typing} G5-0318-04

Additional Classification Information:
Career Prog Id: I:I

Org & Func Code:

1st Skill Code: 03X

2nd Skill Code: 03X

3rd Skill Code: O3

Aquisition Position:

Conp Level: BOC: FLSA: Position Status:
BUS: OPH Func Cd: “* Exempt 4 Conpetitive
Drug Test: H Sub_ject to I/A: N +~ Honexempt o Fungpbad
Agency Use: Hobility: # AFSC/HOS: W SEE (i,
key Pos: Envir, Diff,: & CFI: o HEG CRED
Renarks: o DompdEuenph

Official Pay Plan, Series, Grade and Title :
GS5=-0318-04d Secretary {Typing}

Official Taking Classification Action : Position Hunber (CPCH}: 3IPOOX00150

Hane: Date Established: 1070296
Title:
HEIE | Prev | Save | Exit |

Figure 5-28. Cover Sheet - Page 3

Click the “Save” button to record any changes to the cover sheet. Click the “Exit” button
to return to the COREDOC Edit Menu Screen.

Edit Classification Remarks

To edit the Classification Remarks area, go to the Core Document Edit Menu and click on
the Edit option. From the list of options on the pull down menu click the Classification
Remarks to select the "Classification Remarks" option for the selected position.
"Classification Remarks" is the twelfth option under the Edit option.
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Core Document Development System - Classification Hemarks

CD Hunber: TMPOO327
Title: Secretary (Typing)

Classification Remarks:

Edit | Exit I

Menu Mode = Edit
Count: *1

Figure 5-29. Core Document Remarks

Click the “Edit” button to modify the information in the block designated “Remarks”
while in the screen entitled “Core Document (Remarks)”. This option allows users to add
information which will be included after the system generates classification evaluation.
This section would normally be completed by a classification specialist in their human
resources office. Click the “Exit” button, to return to the Core Document Edit Menu.

Add More Occupations

The thirteenth option on the Core Document Edit Menu, under the Edit option, is More
Occupations. Click the “More Occupations” option and the application will display the
Occupations to Select From Screen (Figure 5-30). This screen contains a listing of other
occupations that users can add to their core document. For example, users can create a
position which requires duties and knowledges for two or more functional areas within
the civilian human resource management fields, such as staffing, classification, and
employee development.
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= Occupations to Select from
Find I%

safety and Occup Health Mgmt:
001 018AG DD Safety and Occup Health Mgmt: Aviation {Ground Safety) o
0018 018CH DD Safety and Occup Health Mgmt: Chemicals & Haz Mats
o018 018CT DD Fafety and Occup Health Mgmt: Combat Training
o018 018EX DD Safety and Occup Health Mgmi: Explosives
0018 018MA DD Safety and Occup Health Mgmt: Maritime
001 018ME DD Safety and Occup Health Mgmt: Medical
0018 016M5 DD Safety and Occup Health Mgmt: Multispecialties
o018 o18MU DD Fafety and Occup Health Mgmt: Munitions {Mon-nuclear)
o018 018HM DD Fafety and Occup Health Mgmt: Muclear Munitions
0028 028 DD Environmental Protection Specialist
00g1 081FF DD Firefighter Fi
i~ i =

Find oK | Cancel |

Figure 5-30. “Occupations to Select From” Screen

Classification Summary

Users can display the Classification Summary by selecting this option under the Edit
option of the Core Document Edit Menu. Click the Classification Summary option from
the list of options on the Edit option. A new menu will now appear titled ‘Classification
Summary’ which provides a brief explanation of the basis for the classification title, pay
plan, series, and grade. At the top of this menu is located the CD number and the
position title. If a position title was not selected then the title block will be blank. A brief
explanation is provided explaining how the percentages of time for the duties affected the
classification. Use the [Arrow] keys to scroll through the summary. Click the “Exit”
button to exit this menu. The information text on this menu can not be edited by the user.
Any changes they have made to the title, pay plan, series, any duty, factor, or Competency
(KSA) will be noted here.

Assigning Position Numbers

Classifiers have the capability to edit a cover sheet and assign a position number only
after a core document has been attached to a Personnel Action Request.

Accessing PERSACTION

As previously mentioned, the FPI Application Main Menu is the entry point into the
PERSACTION, COREDOC, TRAIN, and Regional Applications. Upon selection of the
“PERSACTION?” option, the application takes users to the In Box screen.
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= INBOX NAME: CPO_CHIEF [+
Berquest # PP S5ER GE Organization Form Type Euployee FHCHA
97AF000001 G5 0315 05 4LOJFEZVCC 3F52  FPROMOTION ABZZZ A 7 E
97AFO0000Z G5 0326 04 SPZUF7IISVIFC 5F52  PROMOTION ABZZZIZ MARY A T
97AFOO00003 WG 8563 05 4LOJFHRALGMCC 3F52  PROMOTION ABUAN ROEERT M T
97AFO00022 G5 0203 06 4LOJFDHVDEC 3F52 FILL/RECRUIT T
97AFO000Z7 3F52  FILL/RECEUIT T

&
*N columti: T=Indicates notes are attached to the request.

C columh: ¥=Indicates a core document is attached to the request.

3 column: Y=PTI Response read R=PTI Response received but not read ?=Waiting £/Response
A column: A=Indicates document(s) are attached.

PTI ‘ Print ‘ Batch Print ‘ Attach Doc

‘ Create ‘ E dit ‘ Coordinate

‘ Motes ‘ Delete ‘ Close ‘ Sort ‘ Track ‘ Reports ‘ Quit

Figure 5-31. PERSACTION In Box Screen

The In Box screen, which shows active records, contains actions that the user created, as
well as actions that were sent to the user for coordination or processing. These actions
remain in the In Box until they are coordinated (forwarded) to another In Box, deleted by
the originator, or closed by the Civilian Personnel Office.

To select a request, use the [Up/Down Arrow] key or the mouse to move though the list
and highlight the appropriate selection. If there are several pages of requests in the In
Box, the [Page Up], [Page Down], or [Arrow] keys, as well as the scroll bar, provide
faster means for moving through the In Box.

To attach a core document to an existing Personnel Action Request, click the “EDIT”
button at the bottom of the In Box screen.

The Personnel Action Request form (Figure 5-32) shown on the screen is essentially
identical to the paper form, except it appears as a series of five screens or pages. Users
may press either the [Tab] or [Enter] key, or use the mouse to move from one block to
another. They may also move to another page by clicking the desired page number button
on the lower left hand corner of the Personnel Action Request page.
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= REQUEST FOR PERSONNEL ACTION Page 1 ofb

Current Status Send to Hext Preset Coordination
I Coord

PART A - Requesting Office

Actions Requested Request Hunber
|REALIGNMENT HTE: I | |96AF000154
For Additional Infornation Call <{Hame and Telephone Humber} Prop. Dt {HHDDYY}
Action Requested By Action Authorized By

Hane Hane

Title Title

Request Date I Concurrence Date I

PART B - For Preparation of SF 50 {Use only codes in FPH Supplenent 292-1,
Show all dates - HH-DD-YY}

SS5AN Hame f{Last, First, Hiddle} 0oB  (HHDDYY} |Eff. Dt {HADDYY}

EijEdjdjj oK | £3EY ﬁi&ﬁ@%&il ATTACH | COHEDOCl CAMCEL

Figure 5-32. Page One of the Personnel Action Request Form

Page One of the Personnel Action Request Form contains six command button, including
“COREDOC” and “ATTACH”. The “COREDOC” button allows users access to the
COREDOC System. The “ATTACH” button, allows users to append a previously
created core document to a Personnel Action Request.

Linking a Core Document to a Personnel Action Request

Click the “ATTACH?” button. The application will display the Attach Core Documents
dialog box.
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= Attach Core Document
Find I%
CPCH Hame PP SeHes Gr Title

[IPHAVELDO1 HAVELODOM

IPHAVELODZ HAVELOO1 GS3 o0& 09 Safety and Occupal
IPHAVELOO3 HAVELOD GS oo18 09 Safety and Occupa
SPCOREDODO SAHO0001 GS3 o0& 10 Safety and Occupal
IGPHAVELZ00 SAHOOOM GS oo18 10 Safety and Occupa

TMFO0Z65 GS 0203 05  Personnel Clerk(Offi
9P0DX00151 TMPO0DZ99 GS 0318 04  Secretary

AFD003 GS 0318 04  Secretary

TMPO0344 GS 0318 04  Secretary

TMFO0342 GS 0318 04  Secretary (Office 2

TMPODZ85 GS 0318 04  Secretary (Typing)

TMFO0294 GS 0318 04  Secretary (Typing) |/
i~ I =

Find oK | Cancel |

Figure 5-33. Attach Core Document Dialog Box

The Attach Core Document dialog box shown in Figure 5-34 displays the core documents
in Civilian Position Control Number (CPCN) order. To view the entire list, scroll
through the core document or use the “Find” feature. Click the horizontal scroll bar to
view the CPCN, pay plan, series, grade, title, organization name, incumbent name, and
title of a position.

Highlight the core document and click the “OK” button, the application will then attach
the core document to the Personnel Action Request. If the user wishes to attach a
different core document, they can select the “ATTACH” button again. A pop-up window
will then appear. Click the “ATTACH NEW?” button. The application will again provide
the user with a list of the core documents that were previously created.

Assigning a Position Number

The user may access the COREDOC Edit Menu by clicking the “COREDOC” button
located at the bottom of Page One of the Personnel Action Request. The application will
then display the COREDOC Edit Menu.

Select “Utility” option from the COREDOC Edit Menu. The Utility Menu contains two
options, “System Default” and “Assign CPCN”. The “System Default” option is
available to any user of the COREDOC application. The “Assign CPCN” option is
available only to persons who are designated as “Classifiers” in the Integrated FPI Suite.
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Edit View Reports Utility | Quit Help
Sysism Dafadis .
Assign CPCH

CD Hane: THPOOZ36
Organization: Defense Agency
Connents:
Official Title: Secretary (Typing}
Pay Plan: G5 Series: 0318 Grade: 04 Agency: AF

CLASSIFIER - Default Agency = DD
Count: *1

Figure 5-34. COREDOC Edit Menu Screen

Select the “Assign CPCN” option by clicking it. The application will then display the
Assign CPCN dialog box.

BS Action - Assign CPCN

I Cancel I

Figure 5-35. Action - Assign CPCN Dialog Box

Classifiers can then enter the ten digit Civilian Position Control Number (CPCN).
Classifiers are cautioned that the first two characters of the CPCN must be the Civilian
Personnel Officer Identifier (CPO ID), followed by a five digit core number, and then a
three digit sequential number. The CPCN must also be unique in the Defense Civilian
Personnel Data System (DCPDS).
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Click the “OK” button to save the CPCN. Click the “Cancel” button to return to the
COREDOC Edit Menu screen. The application will then display a confirmation window
that displays the following message: “A CPCN # is now assigned to the CORE
DOCUMENT”. The application will then automatically return the user to the
COREDOC Edit Menu.

View Menu

Users can view and print a core document by selecting the “View” menu from the Core
Document Edit Menu. Users may also save a core document as a text file. For more
information, users should refer to Chapter Three: COREDOC Operating Procedures for
specific instructions on how to view a core document.

Report Menu

The next option on the Core Document Edit Menu is Reports. This option allows users to
display on their screen a variety of views of a core document. COREDOC contains nine
reports: Core Document, Core Document without training competencies, Position
Description, Knowledge, Skills, and Abilities (KSAs), KSAs without training
competencies, Performance Plan, Evaluation Summary, Cover Sheet, and Occupational
Series List. Users should refer to Chapter Three: COREDOC Operating Procedures for
specific instructions on how to view and print these reports.

Utility Menu

When users first use the software, they will be prompted to complete the “System
Default” screen. This screen allows users to designate certain system defaults and
establish a standard goal and organization name for each core document generated. For
more information, users should refer to Chapter Three: COREDOC Operating
Procedures.
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Exit
To exit the Edit Menu screen, click the “File” option then choose “Exit”.

Please Confirm

Are you sure you want to quit
COHriter?

[Yes | W0 |

Figure 5-36. Confirmation Dialog Box

The application will then display a message asking users to confirm their selection. Click
the “Yes” button to exit the COREDOC application and return to the FPI Application
Menu screen. Click the “No” button will return users to the COREDOC Main Menu
screen.

Help Menu

Users can find this options at the right-hand corner of the Core Document Edit Menu
Screen. The Help function has two options, Help System and Show Keys. The Help
System option provides general information about the purpose and general functionality
contained in the COREDOC application. The Show Keys option provides users with
information on using convention keystrokes (Appendix D).
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SAMPLE CORE DOCUMENT

Appendix A-1



CORE DOCUMENT DOCUMENT NAME/#: DoD0001

l. POSITION AND ORGANIZATION INFORMATION
POSITION: Librarian, GS-1410-09
Purpose of position:

The primary focus of this position is to provide professional library and information
Services.

Organizations:
Defense Civilian Personnel Management Service

Organization Goals:

. MAJOR DUTIES
A Duty:
Provides reference and research assistance to library clientele.

Tasks

1. Interviews and interacts with clientele to establish user needs and requirements.
Analyzes user requirements; locates and selects appropriate information resources

2. Access locally available information resources, on-line computer data bases other
libraries, or external subject resources. Devises appropriate service strategies.

3. Explains arrangement and resources of the library; may conduct orientation tours for
specific groups.

4. Instructs users, either individually or in groups, on the use of various audio and/or
electronic database tools.

5. Develops reading lists an subject bibliographies to meet user needs.
6. Performs abstracting and indexing duties,. To meet specializes user needs.

7. Ensure access to information available at other libraries and centers is available
through inter-library loan process. Provides for document delivery to clientele and
open literature and other materials through circulation and procedures.

8. Determines users’ need to know and employs required handling procedures for
classified materials.
Selected Staffing KSAs:

B. Duty (Critical):
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Assists senior librarian or staff member by participating in automation support projects
for specific segments of the library operation.

Tasks

1. Writes portions of procedures manuals for automated library operations.

2. Evaluates equipment and reviews software for use in the library.

3. Instructs library personnel in the use of new software packages and adaptations

4. When the employee serves as librarian-in-charge, responsible for managing network
services, such as Local Area Network (LAN), Wide Area Network (WAN), and
Internet.

Selected Staffing KSAs:
C. Duty:

Responsible for the acquisition of materials for the library collection.

Tasks:

1. Establishes internal procurement and quality processes to ensure appropriate accountability
of library acquisitions.

2. Is responsible for ensuring the most effective acquisition method to purchase or procure
library materials in all formats.

3. Works with vendors to determine product identification, development, and availability.

4. Works with the procurement office to develop purchase agreements and statements of work
for various library services. May serve as the Contracting Officer’s Technical
Representative (COTR) for library procurements.

5. Resolves problems with procurement activity, finance and accounting office, or vendors.

Selected Staffing KSAs:

D. Duty:

Performs original or modified descriptive cataloging in machine-readable cataloging
format where the bibliography characteristics are relatively east to determine and cataloging
decision are made within standard such as the current Anglo-American catalogue Rules
(AACRS) and by comparison to the local database or authority file The assignment of
classification and subject headings can be easily determined by consistently comparing the
content to a stand list of terms, such as the library of Congress Subject Headings.

Tasks

1. Uses standard cataloging rules to catalog material in a variety of formats.
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2. Applies knowledge of automated cataloging system when cataloging in machine-readable
format.

3. Organizes (classifies) and catalogs materials to make them accessible to library uses through
public catalogs.

4. ensures catalog records are accurate and current.
Maintains name and subject authority control records.

6. Obtains input from reference librarians and customers to improve quality of bibliographic
records and access to library materials.

Selected Staffing KSAs:

E. Duty:

Serves as the professional responsible for a small general branch library or limited
specialized collection information resources within a larger academic or technical environment.

Tasks

1. Responsible for library information resource selections, budget, procurements personnel,
facility, or space allocations for the library.

2. Recommends short and long-range library plans.

3. Responsible for reference and research service; determines information needs of the
function. Performs selective dissemination information.

4. Establishes and maintains circulation and interlibrary loan services.

5. Acquires and organizes materials for the collection.

6. Recommends and uses appropriate computer technology.

7. Performs liaison with user groups establishes cooperative linkage with other libraries and/or

information centers, and maintains contact with professional library organizations.
Maintains currency with the library profession.

Selected Staffing KSAs:
F. Other Work Requirements

The employee must obtain and maintain a secret clearance (NAC/NACI).

1. KNOWLEDGES, SKILLS AND ABILITIES (KSAs)

A. Selected Staffing KSAs:
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B. Basic Training Competencies:

1. Master’s Degree in Library Science or two full academic years of graduate education
in a subject-matter field that provided the knowledge required to perform the duties
of the position.

2. Skill in one or more major functional areas of library science, to include, knowledge
of multi-informational sources and access points such as MOASAIC, WAIS, WWW,
STN) and electronic information access, development, and dissemination (Internet,
LANs, and WAN:S).

3. Knowledge of specific subject-matter field, specialized subject or field of endeavor
related to the mission of the serviced organization.

4. Ability to maintain good working relationships with the staff and other associates.

o

Knowledge of on-line database searching and research techniques, and capabilities
of post-processing to meet user requirements.

Familiarity with language(s) appropriate to the position.
Skill in written communication

Skill in oral communication.

© o N o

Skill in developing systems specifications for developers, acceptance testing,
implementation and troubleshooting hardware and software, negotiating site and
software licenses.

10. Ability to apply theories, principles, and practices of classification and of descriptive
and subject cataloging.

11. Ability to plan a library program to meet the mission of the organization.

(\VA CLASSIFICATION FACTORS

Factor 1. Knowledge Level 1 -6 950 points
Knowledge A:

-Knowledge of standard methods, techniques, concepts, and principles of research and referral in
order to perform independent assignments in locating information without significant deviation
from established methods and precedents. Reference services needs are relatively easy to
determine form client interviews or written requests and bibliographic source materials are
readily accessible. A familiarity with a foreign language and/or specialized subject field may be
required.

Knowledge B:

-Knowledge of established library work processes, terminology and standards, bibliographic
utilities, such as the On-line Computer library Center (OCLC) system; database publishers with
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products ( on-line or in tape or CD-ROM format) in the fields of science and technology to assist
with planning, design, implementation, and use of automated systems in a library environment.

-Knowledge of information retrieval technology particularly as it relates to the end-user (i.e.
acquisitions, serials control, cataloging, and optical disk storage of documents) to evaluate
software for library applications and to recognize probable conflicts.

-Knowledge typically found in a graduate of an ALA-accredited masters’ program in library and
information science with either an academic background in computer science or experience in
performing automation projects.

Knowledge C:

-Knowledge of established procurements rules and regulations and internal organization
acquisition policies and those of various networked information centers. A familiarity with
publishers’ and suppliers’ methods of operation.

-Basic knowledge of bibliographic tools necessary and available for the preparation of complete
and accurate order information.

Knowledge D:

-Knowledge of standard methods, techniques, concepts and principles of cataloging in order to
perform independent assignments in classifying and cataloging information without significant
deviation form established methods and precedents.

-A Familiarity of foreign language(s) and/or specialized subject field may be required to catalog
materials.

Knowledge E:

-Knowledge of standard library principles, concepts, methodology, and management to
accomplish the assigned library functions.

-Knowledge of the policies, procedures, systems, and interrelationships of the organization and
clientele served.

Factor 2. Supervisory Controls Level 2 -1 275 points

The supervisory defines the scope of responsibility, objectives, priorities, and deadlines More
detailed assistance is available in unusual situations that do not have clear precedents. The
librarian plans and carries out the successive steps, handles deviation accordance with
instructions, policies previous training, or accepted practices. Completed work is usually
evaluated for technical soundness, appropriateness to the needs of the library and its clientele and
for conformity to policy and requirements.
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Factor 3. Guidelines Level 3-1 275 points

Guidelines include library and agency information policies regulations, and operating
procedures; cataloging rules and formats; authorities lists; subject heading lists; professional and
technical literature, standards; and federal contracting regulations. The guides are not
completely applicable to the work or have gaps in specificity. The librarian uses judgment in
interpreting and adapting the guides for application to specific situations.

Factor 4. Complexity Level 4 -1 150 points
Assignments consist of various duties involving different and unrelated but established processes
and methods Typically, the work consists of proving standard public or technical services of a
relatively nonspecialized nature, or performing a segment or segments of more specialized
services projects. Decisions regarding what needs to be done depend on analysis of each
objective and the nature of the information to be provided or categorized.

Factor 5. Scope and Effect Level 5-1 150 points
The purpose of the work is to apply established practices and techniques to investigate and
analyze a variety of frequently encountered library problems, questions, or situations. The
librarian recommends solutions or courses of action. The work affects other library personnel
and the ability of clientele to perform their missions.

Factor 6. Personal Contacts Level 6 -1 25 points
Regular and recurring personal contacts are with employees in the same agency, but outside the
immediate organization, and with individuals or groups outside the agency in a moderately
structured setting.

Factor 7. Purpose of Contacts Level 7 -1 50 points
The purpose of the contacts is to plan or coordinate work efforts, solve operating problems, or
provide advice to managers and clientele on noncontroversial issues and concerns.

Factor 8. Physical Demands Level 8 -1 5 points
The work is sedentary and includes no special physical demands. It may involve some walking,
standing, bending, or carrying of light items.

Factor 9. Work Environment Level 9-1 5 points

Work involves everyday risks or discomforts typically associated with libraries, offices and
meeting and training rooms. Work areas are adequately heated, lighted, and ventilated.
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V. CLASSIFICATION SUMMARY

In this position:

Duty A. 20% GS-1410-09 Librarian
Reference

Duty B. 20% GS-1410-09 Librarian
Systems

Duty C. 20% GS-1410-09 Librarian
Acquisition

Duty D. 20% GS-1410-09 Librarian
Cataloging

Duty E. 20% GS-1410-09 Librarian
Directs library program

The classification criteria are based on the OPM, FES, Position Classification Standard for the
Librarian Series GS-1410, (T-13) August 1994.

GS-09 Point range: 1855-2100

Total points: 1885
Grade: GS-09
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VI. PERFORMANCE MANAGEMENT PLAN

A. Major Performance Objectives/Individual Performance Standards
Performance Objective 1:
Provides reference and research assistance to library clientele.
Performance Objective 2:

Assists senior librarian or staff member by participating in automation support projects
for specific segments of the library operation.

Performance Objective 3:
Responsible for the acquisition of materials for the library collection.
Performance Objective 4:

Performs original or modified descriptive cataloging in machine-readable cataloging
format where the bibliographic characteristics are relatively easy to determine and
cataloging decision are made within standards such as the current Anglo-American
Cataloging Rules (AACR2) and by comparison to the local database or authority file.
The assignment of classification and subject headings can be easily determined by
consistently comparing the content to a standard list of terms, such as the Library of
Congress Subject Headings.

Performance Objective 5:
Serves as the professional responsible for a small general branch library or limited

specialized collection of information resources within a larger academic or technical
environment.
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APPENDIX B

Occupational Series List - Numerical Order

Series Menu Title

GS-018 018AF Safety & Occupational Health Specialist: Aviation (Flight Safety)
GS-018 018AG Safety & Occupational Health Specialist: Aviation (Ground Safety)
GS-018 018CH Safety & Occupational Health Specialist: Chemical and Haz. Mat.)
GS-018 018CT Safety & Occupational Health Specialist: Combat Training
GS-018 018EX Safety & Occupational Health Specialist: Explosives

GS-018 018MA Safety & Occupational Health Specialist: Maritime

GS-018 018ME Safety & Occupational Health Specialist: Medicine

GS-018 018MS Safety & Occupational Health Specialist: Multi-specialities
GS-018 018MU Safety & Occupational Health Specialist: Munitions (non-nuclear)
GS-018 018NM Safety & Occupational Health Specialist: Munitions (nuclear)
GS-028 028 Environmental Protection Specialist: Medical

GS-081 081FF Fire Fighter

GS-081 081FI Fire Protection Inspector

GS-083 083 Police Officer

GS-0085 085 Security Guard

GS-0203 203PA Personnel Actions Clerk

GS-0203 203CL Personnel Clerk/Assistant (Classification)

GS-0203 203EB Personnel Clerk/Assistant (Employee Benefits)

GS-0203 203ED Personnel Clerk/Assistant (Employee Development)

GS-0203 203ER Personnel Clerk/Assistant (Employee Relations)

GS-0203 203ST Personnel Clerk/Assistant (Staffing)

GS-0204 204 Military Personnel Clerk/Technician

GS-0205 205 Military Personnel Specialist

GS-0305 305 Mail and File Clerk

GS-0318 318C Secretary - Large, Complex Organization

GS-0318 318B Secretary - Medium/Large Office

GS-0318 318A Secretary - Small/Medium Office

GS-0322 322 Clerk-Typist

GS-0326 326 Office Automation

GS-0332 332 Computer Operator

GS-0334 334CS Computer Specialist - General

GS-0034 334DBM Computer Specialist - Database Management

GS-0334 334EA Computer Specialist - Equipment Analyst

GS-0334 334NET Computer Specialist - Network/Telecommunications

GS-0334 334PA Computer Specialist - Programmer Analyst

GS-0334 334PG Computer Specialist - Programmer

GS-0334 334SA Computer Specialist - Systems Analyst
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Series Menu Title

GS-0335 355 Computer Assistant

GS-0343 343 Management and Program Analyst
GS-0344 344 Management and Program Assistant
GS-0346 346 Logistics Management Specialist
GS-0350 350 Equipment Specialist

GS-0390 390 Telecommunications Operator
GS-0510 510 Accountant

GS-0511 511 Auditor

GS-0525 525 Accounting Technician

GS-0540 540 Voucher Examining Series
GS-0544 544 Civilian Pay Technician
GS-0545 545 Military Pay Technician

GS-0560 560 Budget Analyst

GS-0561 561 Budget Assistant

GS-0620 620 Practical Nurse

GS-0621 621 Nursing Assistant

GS-0680 680 Dental Officer

GS-0681 681 Dental Assistant

GS-0682 682 Dental Hygienist

GS-0801 801FAC General Engineer

GS-0808 808FAC Architect

GS-0810 810FAC Civil Engineer

GS-0830 830FAC Mechanical Engineer

GS-0850 850FAC Electrical Engineer

GS-0895 895 Industrial Engineering Technician
GS-0896 896 Industrial Engineer

GS-1071 1071 Audio Visual Specialist

GS-1102 1102 Contract Specialist

GS-1102 1102WS Contract Specialist - Weapons Systems
GS-1105 1105 Purchasing Agent

GS-1106 1106 Procurement Clerk/Technician
GS-1150 1150 Industrial Specialist

GS 1173 1173 Housing Management

GS-1370 1370 Cartographer

GS-1410 1410 Librarian

GS-1410 1410M Librarian (Medical)

GS-1411 1411 Library Technician

GS-1412 1412 Technician Information Specialist
GS-1515 1515 Operations Research Analyst
GS-1670 1670 Equipment Specialist

GS-1712 1712TA Training Administrator
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Series Menu Title

GS-1712 1712TI Training Instruction

GS-1712 1712TS Training Specialist

GS-1740 1740GC Guidance Counselor

GS-1740 1740ES Education Services Specialist
GS-1750 1750 Instructional Systems Specialist
GS-0811 1811 Criminal Investigators
GS-1910 1919 Quality Assurance Specialist
GS-2001 2001 General Supply Specialist
GS-2003 2003 Supply Program Management
GS-2005 2005 Supply Technician

GS-2010 2010 Inventory Management
GS-2030 2030 Distribution Facilities and Storage Management
GS-2032 2032 Packaging

GS-2050 2050 Supply Cataloging

WG-2604 2604 Electronic Mechanic

WG-2610 2610 Electrician Integrated System Mechanic
WG-2805 2805 Electrician

WG-2810 2810 Electrician (High Voltage)
WG-2854 2854 Electrical Equipment Repairer
WG-2892 2892 Aircraft Electrician

WG-3359 3359 Instrumental Mechanic
WG-3414 3414 Machinist

WG-3610 3610 Insulator

WG-3703 3703 Welder

WG-3806 3806 Sheet Metal Mechanic
WG-3808 3808 Boilermaker

WG-3820 3820 Shipfitters

WG-4010 4010 Prescription Eyewear Maker
WG-4102 4102 Painter

WG-4204 4204 Pipefitter

WG-4206 4206 Plumber

WG-4604 4604 Wood Worker

WG-4605 4605 Wood Crafter

WG-4607 4607 Carpenter

WG-4701 4701 General Mechanics and Operator
WG-4737 4737 General Equipment Mechanics
WG-4741 4741 General Equipment Operator
WG-4742 4742 Utility Systems Repairer - Operator
WG-4749 4749 Maintenance Mechanic
WG-5026 5026 Pest Controller
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Series Menu

Title

WG-5210 5210
WG-5306 5306
WG-5334 5334
WG-5402 5402
WG-5406 5406
WG-5423 5423
WG-5703 5703
WG-5704 5704
WG-5725 5725
WG-5803 5803
WG-5823 5823
WG-6904 6904
WG-6907 6907
WG-6910 6910
WG-7002 7002
WG-7402 7402
WG-7404 7404
WG-7407 7407
WG-7408 7408
WG-8602 8602
WG-8852 8852

Total GS Series = 60
Total WG Series =48
Number of Menus: 140

Total All Series = 112

Rigger

Air Conditioning Equipment Mechanic
Marine Machinery Mechanic
Boiler Plant Operator

Utility Systems Operator
Sandblasting

Motor Vehicle Operator
Fork List Operator

Crane Operator

Heavy Mobile Equipment Mechanics
Automotive Mechanic

Tools and Parts Attendant
Materials Handler

Material Expediter

Packer

Baker

Cook

Meat Cutter

Food Service Worker
Aircraft Engine Mechanic
Aircraft Mechanic

As of 05/07/97
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APPENDIX C

Occupational Series List - Alphabetical Order

Series Menu Title

GS-0510 510 Accountant

GS-0525 525 Accounting Technician

WG-5306 5306 Air Conditioning Equipment Mechanics
WG-2892 2892 Aircraft Electrician

WG-8602 8602 Aircraft Engine Mechanic

WG-8852 8852 Aircraft Mechanic

GS-0808 808FAC Architect

GS-1071 1071 Audio Visual Specialist

GS-0511 511 Auditor

WG-5823 5823 Automotive Mechanic

WG-7402 7402 Baker

WG-4602 4602 Blocker and Bracer

WG-5402 5402 Boiler Plant Operator

WG-3808 3808 Boilermaker

GS-0560 560 Budget Analyst

GS-0561 561 Budget Assistant

WG-4607 4607 Carpenter

GS-1370 1370 Cartographer

GS-0810 810FAC Civil Engineer

GS-0544 544 Civilian Pay Technician

GS-0322 322 Clerk-Typist

GS-0335 335 Computer Assistant

GS-0332 332 Computer Operator

GS-0334 334CS Computer Specialist - General

GS-0034 334DBM Computer Specialist - Database Management
GS-0334 334EA Computer Specialist - Equipment Analyst
GS-0334 334NET Computer Specialist - Network/Telecommunications
GS-0334 334PA Computer Specialist - Programmer Analyst
GS-0334 334PG Computer Specialist - Programmer
GS-0334 334SA Computer Specialist - Systems Analyst
GS-1102 1102 Contract Specialist

GS-1102 1102WS Contract Specialist - Weapons Systems
WG-5725 5725 Crane Operator

GS-1811 1811 Criminal Investigator

GS-0681 681 Dental Assistant

GS-0682 682 Dental Hygienist

GS-0680 680 Dental Officer

GS-2030 2030 Distribution Facilities and Storage Management
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Series Menu Title

GS-1740 1740ES Education Services Specialist
GS-850 860FAC Electrical Engineer

WG-2854 2854 Electrical Equipment Repairer
WG-2805 2805 Electrician

WG-2810 2810 Electrician (High Voltage)
WG-2610 2610 Electrician Integrated System Mechanic
WG-2604 2604 Electronic Mechanic

GS-028 028 Environmental Protection Specialist
GS-0350 350 Equipment Operator

GS-1670 1670 Equipment Specialist

GS-0081 081 Firefighter

WG-7408 7408 Food Service Worker

WG-5704 5704 Fork List Operator

GS-0801 801FAC General Engineer

WG-4737 4737 General Equipment Mechanics
WG-4741 4741 General Equipment Operator
WG-4701 4701 General Mechanics and Operator
GS-2001 2001 General Supply Specialist

GS-1740 1740GC Guidance Counselor

WG-5803 5803 Heavy Mobile Equipment Mechanics
GS-1173 1173 Housing Management

WG-3359 3359 Instrument Mechanic

GS-0896 896 Industrial Engineer

GS-0895 895 Industrial Engineering Technician
GS-1150 1150 Industrial Specialist

GS-1750 1750 Instructional Systems Specialist
WG-3610 3610 Insulator

GS-2010 2010 Inventory Management

GS-1410 1410 Librarian

GS-1410 1410M Librarian (Medical)

GS-1411 1411 Library Technician

GS-0346 346 Logistics Management Specialist
WG-3414 3414 Machinist

WG-4749 4749 Maintenance Mechanic

GS-0305 305 Mail and File Clerk

GS-0343 343 Management and Program Analyst
GS-0344 344 Management and Program Assistant
WG-5334 5334 Marine Machinery Mechanic
WG-6910 6910 Material Expediter
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WG-6907 6907 Materials Handler

WG-7407 7407 Meat Cutter

GS-0830 830FAC Mechanical Engineer

GS-0545 545 Military Pay Technician

GS-0204 204 Military Personnel Clerk/Technician

GS-0205 205 Military Personnel Specialist

WG-5703 5703 Motor Vehicle Operator

GS-0621 621 Nursing Assistant

GS-0326 326 Office Automation

GS-1515 1515 Operations Research Analyst

WG-7002 7002 Packer

GS-4102 4102 Painter

GS-0203 203PA Personnel Actions Clerk

GS-0203 203CL Personnel Clerk/Assistant (Classification)

GS-0203 203EB Personnel Clerk/Assistant (Employee Benefits)

GS-0203 203ED Personnel Clerk/Assistant (Employee Development)

GS-0203 203ER Personnel Clerk/Assistant (Employee Relations)

GS-0203 203ST Personnel Clerk/Assistant (Staffing)

WG-5026 5026 Pest Controller

WG-4204 4204 Pipefitter

WG-4206 4206 Plumber

GS-0083 083 Police Officer

GS-0620 620 Practical Nurse

WG-4010 4010 Prescription Eyewear Maker

GS-1106 1106 Procurement Clerk/Technician

GS-1105 1105 Purchasing Agent

GS--1910 1910 Quality Assurance Specialist

WG-5210 5210 Rigger

GS-018 018AF Safety & Occupational Health Specialist: Aviation (Flight Safety)

GS-018 018AG Safety & Occupational Health Specialist: Aviation (Ground
Safety)

GS-018 018CH Safety & Occupational Health Specialist:Chemical and Haz. Mat.)

GS-018 018CT Safety & Occupational Health Specialist: Combat Training

GS-018 018EX Safety & Occupational Health Specialist: Explosives

GS-018 018MA Safety & Occupational Health Specialist: Maritime

GS-018 018ME Safety & Occupational Health Speciialst: Medicine

GS-018 018MS Safety & Occupational Health Specialist: Multi-specialities

GS-018 018MU Safety & Occupational Health Specialist: Munitions (non-
nuclear)

GS-018 018NM Safety & Occupational Health Specialist: Munitions (nuclear)

WG-5423 5423 Sandblaster
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GS-0318 318C
GS-0318 318B
GS-0318 318A
GS-085 085

WG-3806 3806
WG-3820 3820

GS-2050 2050
GS-2003 2003
GS-2005 2005
GS-0390 0390
WG-6904 6904
GS-1712 1712TA
GS-1712 1712TI
GS-1712 1712TS

WG-5406 5406
WG-4742 4742
GS-0540 540

WG-3703 3703
WG-4605 4605
WG-4604 4604

Secretary - Large, Complex Organization

Secretary - Medium/Large Office
Secretary - Small/Medium Office

Security Guard
Sheet Metal Mechanic
Shipfitter
Supply Cataloging
Supply Program Management
Supply Technician
Telecommunications Operator
Tools and Parts Attendant
Training Administrator
Training Instruction
Training Specialist
Utility Systems Operator
Utility Systems Repairer - Operator
Voucher Examining Series
Welder
Wood Crafter
Wood Worker

Total GS Series: =64
Total WG Series: =48
Number of Menus: 140

Total All Series: =112

As of 05/07/97
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APPENDIX D

Special Keys In COREDOC

Function Hot Key Description

Accept Ctrl - F7 Save the exiting Core Document
Clear Block Ctrl - b Clear highlighted block

Clear Form Shift - F5 Clear all blocks on a form

Clear Record Ctrl - F5 Clear record

Count Query Hits Ctrl - q Display the count of records
Debug Mode Ctrl - F4 Self-explanatory

Delete Backward Backspace Delete one character in a block
Delete Record Ctrl - d Delete an entire record

Display Error Ctrl -0 View an error report

Down Down Arrow Move to the next screen

Edit Ctrl - e Open an exiting Core Document
Enter Query Ctrl - F3 Begin query mode

Exit Alt - F4 Close the current session

Help Ctrl - h List Help topics

Insert Record Ctrl - i Add a new record

Left Left Arrow Move one block to the left

List of Values Ctrl - | Display list of values

Main Menu Shift - F11 Return to COREDOC Main Menu
Next Block Page Down Move to the next block

Next Item Tab Move to the next item

Next Record Shift - Down Arrow | Move to the next record

Next Set of Records Ctrl -s Move to the next set of records

Previous Block Page Up Move to the previous block
Previous Item Ctrl - Tab Move to the previous item
Previous Menu Shift - Tab Return to the previous menu

Previous Record

Shift - Page Up

Return to Previous Record

Print

Ctrl -P

Print the current core document

Redefine Username/Password | Ctrl - j Allows user to change password
Return Return Move to previous block or form
Right Right Arrow Move to the next block or form
Show Keys Ctrl - k Display special function keys
Toggle Insert/Replace Alt - F8 Switch in/out of overtype mode
Up Page Up Move to previous block or form
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Appendix E

Import and Export PC Core Documents

The Import Core Document option allows a user to select standard and regular core
documents for import from the CDWriter 2.0 (PC version) into the Integrated PPI Suite.

There are three basic steps involved in the process of importing PC version core documents
into the Integrated PPI Suite:

1. Export as an ASCII file from CDWriter version 2.0,

2. Use File Transfer Protocol (FTP) to export the files from the PC version to the
UNIX host,

3. Import core documents into Integrated PPI Suite.

Exporting and Importing Core Documents from PC version of CDWriter

To initiate a CDWriter session, go to the Windows Program Manager Screen and click the
icon that contains the PC version of CDWriter, if this application is resident on the users
computer. This will initiate the “Logon” Screen for CDWriter. Users may press either the
[Tab] or [Enter] key, or use the mouse to move from one block to another.

After entering the users assigned Username, press the [Enter] key to go to the “Password”
block. After entering the users assigned password, press the [Enter] key. The CDWriter
Main Menu Screen will appear after successful Logon. The CDWriter Main Menu Screen
contains eight icons: Open, New, View, Print, Import, Export, Help and Exit. The Menu
Bar contains nine options: File, New, Open, View, Print, Tools, Utility, Help, and Quit.
The user can use either the icon or the menu bar to import or export a Core Document into
another application such as the Integrated PPI Suite. The preferred method is to use the
icons, Import or Export, to perform this function versus the menu bar. The methods for
processing the actions are the same whether the Menu Bar is used or the icons on the CD
Writer Main Menu Screen.
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= CDWriter Occoquan

File New ©Open Yiew Print Tools Utility Help Quit

Main Menu:

This is the main menu for CDWriter, software developed to implement the
[COREDOC system. Using this system you can create a core document. Press
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Figure E-1. CDWriter Version 2.0 Main Menu Screen

LOCATING A CORE DOCUMENT.

Using the mouse or the [Tab] key, highlight “Utility” from the Menu Bar, and press the
[Enter] key. The application will display a pull down menu containing two options,
“System Defaults” and “Default Goals and Organization Name” (Figure E-2). Systems
Administrators will have access to additional options within this area. Click the “System
Default” option. Figure E-3 is displayed.

CDWriter Gccoquan
UL Help Quit
System Defaults
Default Goals and Organization Name

File HNew Open ¥Yiew Print Tools

Main Menu:

This is the main menu for CDWriter, softw 4
[COREDOC system. Using this system you cal
the <F1> key if you need more information

CDWRITER

DEVELOPMENT

Figure E-2. CDWriter Version 2.0 (PC Version) Utility Menu Screen
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Users should review the user’s default options and make any necessary modifications. For
example, the “Output Format” should be set for a “Core Document. Using the [Tab] and
enter keys, select the correct “On/Off Settings” for the Core Document. Tab to the “Export
to” block and use the mouse to move the arrow up and down to select the correct file type.
Highlight the “ASCII File” and then press the [Enter] key. Tab to the “Default Path” data
block. Set the default path and directory, if desired, e.g., “C:\corefile\” for the core
document that will be exported and imported. Also select the correct Agency for the Core
Document. To save this entry, click “OK”.

= CDWriter Occoquan
Tools Help
System Defaults:
Use the <Tab> key, or <Shift><Tab> to more hetween options. Press
<Enter> key to szelect an option. Press <Ctrl1><Enter> to save, when done,
or <Esc> to gquit without saving. Press <Fl> for detailed help on each
// /'/ -
/// v o : /"// .
v /// | Output format: Onloff settings for .
,.///'//;,,.- ® Core Docurnent B Critical™oncritical
~ | o Position Description ® Percentage ferWS P05|t|qrjs . <]
Sd B Show KSA Linkage to specific duties o
. O Automatic Staffing KSAs selections i
- i o
Printer Setup | g
el Exportto: ASCII FILE ——
|~ | Default path for export (backup) and import {restore):
/Qp/erf (o
| Agency
i / '/' & ]
/'J/,-’./ '/.
- Miew
/’_/J'_/"'/
. | | cancel |
s -"/_/" - T

Figure E-3. CDWriter Version 2.0 (PC Version) - Systems Default Screen

From the Core Document Main Menu Screen (Figure E-1), use the [Tab] key to highlight
“File” on the Menu Bar and press the [Enter] key. Use the mouse or the [Down Arrow]
keys to highlight “Export CD” option and press the [Enter] key. The application will
display a pull down menu containing three options, “Export a CD From Your Folder to
Drive A:”, “Export a CD From Your Folder to Drive B:”, and “Export a CD From Your
Folder to User Default Directory” (Figure E-4).
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CDWriter Occoquan
|5l New Open View Print Tools Utility Help Quit

New “N

Open “0

Delete “D

View mu for CDHriter, software developed to implement the

Brint ing this system y¥ou can create a core document. Press

— need more information.

L 4 —
Export CD Exporta CD From Your Folder to Drive A:

Use Standard CD

Copy
Rename

Exit

Export a CD From Your Folder to Drive B:
Exporta CD From Your Folder to User Default Directory

1-TMP00010
2 - TMP00009
3 - TMP00008
4 - TMP00007

Figure E-4. CDWriter 2.0 Version (PC Version) - File Menu Screen

Once the export selection has been made from the screen in Figure E-4, Figure E-5 is
displayed with the names of the Core Documents. To select the correct document to
export, highlight the document, and press [Enter]. The Export a CD File Screen (Figure
E-6) is displayed.

= CDWriter Occoquan

File HNew ©Open ¥Yiew Print Tools Wility Help Quit

Main Menu:

This is the main menu for CWriter, software developed to implement the
COREDD system. Using this system you can create a core document. Press
the <Fl1l> key if you need more information.
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E-5. CDWriter Version 2.0 (PC Version) - Core Document Listings Screen
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Changes to the Export a CD File Screen (Figure E-6) can be made at this time to the name
of the file and the path. Follow the instructions given on the screen to complete the export
function. The CD name can contain up to eight characters. However, users are cautioned
NOT to use punctuation marks in the file name. Press [Enter] to export the file. Figure E-
8 is displayed to confirm the document has been saved. Press any key to continue within
the CDWriter Version 2 (PC Version).

= CDWriter Occoquan

Tools Help

Main Menu:

This is the main menu for CDMriter, software developed to implement the
[COREDOC system. Using this system you can create a core document. Press
the <F1> key if you need more information.

,,,,,,, e

Exporta CD File L

- _'/'//.

| Path:  C 7

| | Thiooos //

| Please name your file, name can be up to 8 characters long .
Include the complete path if itis different from the path shown

above, Don'tuse puctuation marks in the file name. The _

extention .cdw will automatically be added. |

Figure E-6. CDWriter Version 2.0 (PC Version) - Export a CD File Screen

If help is needed with the Export function, a help screen is available (Figure E-7). Press
“Help” from the Menu Bar to display the help information.

== CDWriter Occoquan

Tools Help

Press any key to return to previous screen

Export a core document:

Export a core dooument:

This option allows wou to export, or save, your core document to a £floppy
disk or to another location on your hard drive, or even to another
location on the local area network. This i=s useful when you are using
the program as a stand alone application or when your network does not
connect with the network for the human resources office.

fhen you select Export, you are shown three choices: Export to drive A,
Export to drive B, or Export to the hard drive. Before wvou saelect to
export, or =save, to drive A or B, be sure you hare a floppy disk in the
drive. If yvou export to wour hard drive, select a path that exi=sts,
otherwise the system will not allow wyou to export to a non-existent
directory.

Figure E-7. Help Screen for Exporting a Core Document
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Standard Core Documents

If users are exporting a standard core document, the first letter should always begin with a
“S” and followed by the 2-character Agency Code, an underscore (“_"), and then four
additional characters (alpha-numeric) to make the name unique. For example, if the
Standard CD was created for the Air Force, the name of the export file would be
“SAF_0001".

Regular Core Documents

If users are exporting a regular core document, the first letter should always begin with a
“R” and followed by the 2-character Agency Code, an underscore (*_""), and then four
additional characters (alpha-numeric) to make the name unique. For example, if the
Regular CD was created for the Air Force, the name of the export file would be
“RAF_0001".

After the correct path and file name are entered on the screen, press the [Enter] key. The
application will then display a Confirmation Screen.

= CDWriter Occoquan
Tools Help

//,'./ // A . // P //. P ,/ ''''''''''''' | b o s ..'.’ ,/. .'/.
2o // ,_/ e G e e s
// ’/’/ i ,-’//I. P i 7 ’/
e e e
,//// L /'/'/ Sam
S s o e e . ; -
R s e i i R i /,/ o /.'/' 0
i A £ EA. S
’/ | Your core document has been saved for future use. / ,///' -

// e // b i o
PRt - . S
o The file name is : C:\THOOO1 Co
Lo o
. ] . ] .
'~ | To reopen this core document, select F)ile from the Hain | = = =
7 /| Menu, and use the Import Option and the name shown above. |~ ,//-",
/.’ e S ,/’//'

~ | If you intend to work on a different computer when you '//"__,/
///// work on this description, make sure that the Occupation .

.~ /| Libraries used to create the document are on the new .
" | computer. .

e D

s // o

« Press any key to continug 2

Figure E-8. CDWriter Version 2.0 (PC Version) - Confirmation Screen

The Confirmation Screen will display a message indicating the complete file name, e.g.,
C:\TMPO0001” for the export file. Press any key to continue.

To import a CD into the PC Version of CDWriter, click the Import icon from the Main
Menu Screen. The Open Screen (Figure E-9) is displayed.
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= CDWriter Occoquan
File HNew Open View Print Tools Utility Help Quit

Wain Menu:

This is the main menu for CDMriter, software developed to implement the
COREDOC system. Using this system you can create a core document. Press
the <Fl1> key if you need more information.

- 7
~ | Import aCD file Directory: I .
* cdw | c\cmtemp} o
] [tm0002.caw + [Ec + <
| |tmp00001 .caw emp -
“ A |tmp00005.cdw e
] All Files

+ +

Drive:

= Y

i
| | Iy | I I

Figure E-9. CD Writer Version 2.0 (PC Version) - Import Screen

Select the directory and file name where the core document was saved. Then, continue to
work on the imported document in the CDWriter Version 2.0 (PC Version). To import the
saved core document into the PPI Suite of COREDOC, contact the systems administrator
for further instructions or follow the instructions on the screen.

FTP from PC to UNIX Host

Users can utilize several different File Transfer Protocol (FTP) program applications to
move a core document to the UNIX host. Currently there are three applications, including:
Microsoft FTP, Oracle FTP, and WS_FTP

Regardless of which FTP application users select, always be sure that the transfer protocol
is set to ASCII! Before beginning the file transfer, refer to the application’s Help File
documentation on how to proceed with File Transfer. The UNIX Host directory to FTP
the ASCII files should be “/tmp”.

For illustration purposes, the WS_FTP application will be used to export files into UNIX
host.

FTP into Open System

Locate the WS FTP icon in Network group in Program Manager. Double click the WS
FTP icon to activate it. Users should take a minute to familiarize themselves with the
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available options. The left portion shows the Local PC from where the CD’s are present
and right portion shows the Remote Host (the place users want to import). Press the
“Connect” button located at bottom left of the screen. The application will display the
WS_FTP Main Menu Screen (Figure E-9).

= WS _FTP ~]-]

| Local PC info | Femate host info

C:adS \ |

Chaglrir

Chaglrir

readme . txt
ws_ftp.exe

ws_ftp.hlp

ws_ftp.ini

ws_ftp.txt

ws_read.me

« | *| Delete | Delete

4501 @ Binary e
WINMSOCK.DLL: Microzoft Windows Sockets Version 1.1,
WS_FTP werzsion 94.03.25, copyright 1334 John A, Junod

Catirect l Cancel I LatigDir I Help I Options I &bt I E uit

Figure E-10. WS_FTP Main Screen

The WS_FTP Main Screen connects users to the system stated in the text-box, Config
name and Host name. In some versions, the “Connect to” dialog box is also called a
“Session Profile”. Complete all the boxes (Figure E-11) and press “OK” to return to the
WS_FTP Main Menu Screen (Figure E-12).
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Config name: |w |@ Retiy: ICI
|ﬁn-::h | Timeout:

I%ﬂ [ ] Anonymous Login
| [] Save Pazsword
| | ] Use Firewall

| ecarpent

|
| ftmp |
|

| auto detect

| ecarpent

| Set Firewall Info 5

Remote Dir

Local Dir | c:\ftpzips

| Save Config i |Qelete Config i | Help i | Cancel i | 1] 4 a

Figure E-11. Connect In... Dialog Box

Users will notice both the Local PC information and Remote host information sections
now contain information. Select the directory containing the Core Documents in the Local
PC top section. The bottom section displays the related files similar to any file manager.

Important: Please change the radio button from Binary to ASCII before selecting any

files.

Select the directory in Remote host information where users want the CD’s to be imported

(Figure E-12).

WS FIP finch
| Local PC info | Remote host info
CAFTPZIPS | Atrop |
TESTER I Shetr | lost+Found |
[-a-] bk Diir o bk Diir
[_h_] ...................... rhl ......................
[-c-] Rmlrir sbin FimCrir
[-d-] | — syscore |/ 1
'A'-'A'
ascii.c k3 - 4-page I I:l
checkall L e 5856 .ps L e
chkdeps | |l croutUilpaaeeet1e | |l
cor?.txt Eeme last_uuid Eeme
gogetem | [l— multi-page @ | |=———
gogetem ||| Rename da_ 8614 ._cdu ||| Rename
holdem ry da 8828 . cdu oy
] |_' Delete A E |_' Delete
@.t‘l'« _* Binamy rLe
Received 1314 bytes in 0.1 secs, [10.00 Kbytes/zec), transfer succeeded
226 Tranzfer complete.
Cloze 5 Cancel ﬂ Longlir ; Help 5 Options i About i E xit

Figure E-12. WS-FTP Main Menu Screen

Appendix E-10



Note: Regular CD’s start with ‘r’ and Standard CD’s start with ‘s’ in the file directory of
the Remote host.

= WS_FTP finch (v |«
|Lu:uc:a| PC info |F|emu:ute hiozt imfo
Ak | Stmp |
- [+
lost+found |
o
rbl
sbin
syscore +
*.*
rda_@a62e. 4-page L+
rdd_8811. Vi L8L6.ps -
rmc_ 8816, I croutUWaadgeo1e
rng_08e17. Brem <\ |1ast_uuid
sda_Beea. multi-page -
sda_@e18. Rename |\ | rda_ao14 . cdw Rename
rda_B88208.cdw + |
i Delets T | Yy Dielete
® A5  Binary OLe
Received 1314 bytes in 0.1 secz, [10.00 Kbptes/zec, tranzfer succesdead
226 Tranzfer complete.

Figure E-13. WS-FTP Main Menu Screen

Select CD’s to be exported from the bottom left as shown. Import them to the Remote host
by pressing the “-->” button from the center of the WS_FTP Screen indicating the direction
of transfer of files.

Import of the CD into Coredoc PPI Suite (System Administrator)

Open the COREDOC Application in the PPI Suite and select “Utilities” from the Menu
Bar. Users see the following options as shown in Figure E-14.

System Defaults

System Administration

Figure E-14. Utilities Menu

Click System Administration, if a system administrator, and the application will display
the COREDOC System Administration Screen. Click “Action” on the Menu Bar (Figure
E-15).
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Core Document Development System - System Administration

Figure E-15. Action Screen - PPI Suite COREDOC Application

The following drop down menu appears (Figure E-16).

Figure E-16. Action Menu Screen

Select “Import PC Core Documents” (Figure E-16). The CD Import Screen is displayed
(Figure E-17).
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— Core Document Development System - CD Import I_l_

R e ——

Figure E-17. CD Import Screen

Select “Action” from the Menu Bar. Figure E-18 is displayed. Select “Process ASCII
Files” option.

Figure E-18. Process ASCII Files Menu

The application will display an Oracle Forms Message Box that states “Users must
ICONIZE the Main Window in order to view the UNIX X-term window” (Figure E-19).

Oracle Forms

E|

Figure E-19. Iconize Screen
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Press the “OK” button. Click the “control bar” to minimize the Main Window. The
application will then display the UNIX X-Term window (Figure E-20). Users may now
observe the processing status, if desired.

HE R #H4  # o R R B
# # # # #H  HE # # # # # # #
# # # #F H### # # # # # #
# # # # % # HEEEE # # HHEEEE #
# # # # # # # ## # #
# # # # # # # # # # # #
HHEE B #H4  # # # HiHHHE # # #

hu Oct 10 08:21:27 COT 1996

% Note to zcroll forward press 4d) - to scroll backwards press (“d}
* The ™ meanz to prezz and hold the Ctrl key,.,.

% To exit the log press (92

==r»Procezzing import file Atmpdrda_0014,cdw

onnected to ORACLE,

hiz iz file 1 under the name Atmpdrda_00ld, cdw
11 1 files have been szuccessfully loaded, Have a good day!

emoving import file Atmpdrda_0014, cdw
FrProcessing import file Atmpdrda_0020,cdw

onnected to ORACLE,

Figure E-20. UNIX X-Term Window

The UNIX system will check all the CD’s available for import, load, and then process

them. Press “q” to exit the viewer. Press “y” to print a copy of the log.

Double click the Main Window Screen which has been “iconized” in the previous step.
The application will again display the COREDOC System Administration Screen shown in
Figure E-15.

Click “Action” on the Menu Bar and the application will display a drop down menu
containing three options, “Select CDs for Import”, “Delete CDF Entries” and “EXit”
(Figure E-21).

Select CDs for Import ™
Delete CDF Entries - Standard CDs

Exit Reqular CDs

Figure E-21. Select CDs for Import Menus

Click the “Select CDs for Import” option, the application will then display another drop
down list allowing the user to select, “Standard CDs” or “Regular CDs”.
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For illustration purposes, the user selects “Regular CDs” option. The application will then
display the Action -Please Select... Dialog Box (Figure E-22).

Action - Please Select...

There are© Regular Core Docunrents
to be loaded, Do you want to assign
9 then all to the SAHE author {user_id?

or assign then individually to
DIFFERENT authors?

Sane I Different I

Figure E-22. Action - Please Select... Dialog Box

Users are given the option to assign all of the regular core documents to the same user_id
or to assign them individually to different user_ids (Figure E-23).

=| PERSACT Users

|%
User ID

ADOLL

AR

ARMYCPO
AR_CPO_CHIEF
AR_CPO_CLASS
AR_CPO_CLASSZ

AR_CPO_CLASS3
AR_CPO_STAFF
AR_CPO_STAFF2
AR_CPO_STAFF3
AR_SUPER

| =

Find oK | Cancel |

Figure E-23. PERSACT Users Dialog Box

Select a “User_id” and a message box confirms that core documents are being loaded.
After the documents are loaded, the application will automatically display the Core
Document System Administration Screen (Figure E-15). Select “Action” to see if any
additional documents are to be loaded. Exit if everything has been loaded.
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Exit

To exit the COREDOC application, click the “Exit” option from the System
Administration Menu Bar (Figure E-15). Click the “Action” Option from the Menu Bar

and then select the “Exit” Option.

Please Confirm

Figure E-24. Confirmation Dialog Box

The application will then display a message asking users to confirm their selection. Click
the “Yes” button to exit the COREDOC application and return to the PPl Application
Menu Screen. Clicking the “No” button will take users back to the COREDOC Main

Menu Screen.
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APPENDIX F

“ATTACH DOC” Instructions

for CDE Runtime Users

Appendix F-1



Appendix F
“Attach DOC” Instructions for CDE Runtime Users

This appendix covers the “ATTACH DOC” procedures for the Coredoc and Persaction
records. This procedure is available ONLY for those individuals who are using CDE
Runtime. Users of X-Vision and other operating applications DO NOT have this
capability.

To attach a document, click “Attach Doc” at the bottom of the Persaction In Box Screen
(Figure F-1).

= INBOX NAME: CPO_CHIEF [~ ]
Becuest # PP SER. GR Organization Form Type Enploves *NCSA
S7AFOOO00L G3 05 4ALOJFEZVCC 5F52Z  PROMOTION ABZEZZ MARY & i e
ST7AFOOO0ODZ G3 03zZ6 04 SPEUFTIJISVEFC 3F5Z FPROMOTION ARZEZZ MARY & T
STAFOOO0O3 WG 3563 05 4LOJFHRELGHMCC 3F5Z FPROMOTION AEUAN ROEERT M T
STAFOOOOZZ G3 0203 06 4LOJFDHVDPC S3F5Z FILL/EECEUIT T
STAFOOOOZ7 S3F5Z FILL/EECEUIT T
=

*W column: ¥=Indicates notes are attached to the request.

C column: ¥=Indicates a core document is attached to the redquest.

3 column: ¥=PTI Response read FE=PTI Response receiwved but not read ?=Waiting £/Response
A column: A=Indicates document (s) are attached.

| Create I | E dit I | Coordinate I | PTI I | Print I | Batch Print I Attach Doc

| Motes I | Delete I | Closze I | Sort I | Track I | Reports I Quit

Figure F-1. PERSACTION In Box Screen

The Attached Documents Screen (Figure F-2) is displayed. Click the “Add” button.
Place the mouse pointer inside the Document block section when the screen is displayed
and click the right mouse button. The pull down menu in Figure F-3 is displayed. When
the “Add” button is selected, the users name is automatically entered in the “Attached
By” data field. The “Description” data field is enabled to allow the user to enter a brief
description of the document to be entered into the Attached Document of Request Screen
field. Click the Insert Object for the type of document to be inserted into the Attached
Document of Request Screen (Figure F-3). Clicking Insert Object displays the Insert
Object Screen (Figure F-4).
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== Attached Document(s] for Request 97AFPCO00044

Description: I Attached By: |

Document [hold down the right mouse button on this object for OLE menu]):

==

Figure F-2. Attach Document Request Screen - Blank

= Attached Document(s] for Request 37DEB1000043

o | [ox_J[eancec |

Description: | Attached By: |Dehhie Spilman

Document [hold down the right mouse button on this object for OLE menu]:

Cut

Copy
Paste Ctrl+¥

Paste Special...

Delete Object
Links...

Insert Object...
Object

e | e [ |

Figure F-3. Pull Down Menu Screen Within the Request Data Screen
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= Insert Object

Object Type:

Microsoft Excel Worksheet +

Microsoft Graph 5.0
. Microsoft Organization Chart 1.0

O Create from Eie:

Microsoft Yord 6.0 Picture

Microsoft WordArt 2.0

MS PowerPoint 4.0 Presentation [" Display As lcon

MS PowerPoint 4.0 Slide
Package +

0K

@ Create New:

Cancel

Result
Inserts a new Microsoft Word 6.0 Document
Eﬁ object into your document.

Figure F-4. Insert Object Screen

Click the Create New Button to create a new file or click Create from File to insert a
previously written file. Select Object Type by using the scroll bar to locate the type of
document to be created by the user. Highlight the needed document and click “OK”. To
create a new document, select “Create New”, “Object Type”, and then click “OK”.
Figure F-5 gives an example of a Word 6.0 Document. After creating the document, exit
the application by selecting “File” and then “Exit” from the Menu Bar. The document
will be saved in the database. To save a copy of the document to the hard drive, select
“File” and “Save Copy As” from the Menu Bar. Then “Exit” to exit the application.
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= Attached Document(s] for Request 97AFPCDDDDA4 H
Descrption: | Attached By: |Dehhie Spilman

Document [hold down the right mouse button on this object for OLE menu):

Thisis a document being created using the Attach Document option
from the InBox.

[ e | [T e Coiow | [[_ox_ [ cancec |

Figure F-5. Screen Displayed When Select Object Type Selected

To attach an already existing document, select the “Create From File” button. Figure F-6
is displayed. If the file name of the document is known, enter the file name with the
correct drive and directory to the File Field. If there is a need to visually locate the
document, press the Browse... button. This displays the standard Windows dialog box for
locating a file. Simply follow the normal process in selecting the desired file.

= Insert Object

0K

C Create New:

File: Cancel

@® Create from File: | clattach}

[" Display As Icon

Result

Inserts the contents of the file as an object into
: = your document so that you may activate it using
E the application which created it.

Figure F-6. Create From File Screen
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By selecting “Display As Icon” the appropriate icon will be displayed beneath the Display
As Icon area on the Insert Object Screen (Figure F-7). The icon will also be displayed in
the Attached Document screen area (Figure E-8).

@ Create New:

O Create from File:

= Insert Object

Object Type:

0K

Microsoft Excel Worksheet
Microsoft Graph 5.0

Microsoft Word 6.0 Picture
Microsoft WordArt 2.0

MS PowerPoint 4.0 Slide
Package

Microsoft Organization Chart 1.0
Microsoft YWord 6.0 Document

MS PowerPoint 4.0 Presentation X Display As Icon

| Cancel

-

Result

ﬁ

Inserts a new Microsoft Word 6.0 Document
object into your document. It will be displayed

as an icon.

Document

| Change lcon...

Figure F-7. Display As Icon on Insert Object Screen

Attached Document(s] for Request 97AFPCO00044 H

Description: |Jusliﬁcaliun for Over Hire

Document [hold down the right mouse button on thiz object for OLE menu):

Attached By: |Dehhie Spilman

Document

provoe o | [ J|_eon ][ oot |

Figure F-8. Attached Documents Screen with Icon and Buttons
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Attached Document Buttons

To view and edit the attached document, click “Edit” at the bottom of the screen and the
associated application will be launched. For example, click the Edit button and Microsoft
Word will be launched with the document open. Corrections, additions, or deletions can
be made to the document.

The “Next/Previous” buttons are used to navigate through the attached documents when
multiple documents are attached. When the “Next” button is gray, there are no additional
documents attached. When the “Previous” button is gray, the user is at the first attached
document.

Attachments are deleted by selecting the “Delete” button. There is no confirmation
screen to make sure the user really wants to delete the document . To recover the
document, select the “Cancel” button.

Selecting the “Cancel” button allows the users to abandon all changes made to attached
document(s). The “Cancel” button can also be used if no changes were made to the
attached document(s) and no document(s) were added.

Select the “OK” button to exit the Attached Document form and save any changes made.
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June 1997

COREDOC Quick Help for Personnelists

Initiating a COREDOC Session

Open COREDOC by clicking the Integrated Personnel Process Improvement (PPI) Suite icon from the
Program Manager screen.

Type your Username and press the [Tab] key. Enter your password. Click the “CONNECT” command
button. The application will display the PPl Application Menu screen.

Click the “COREDOC” option. If this is the first time accessing the COREDOC system, the application will

display the System Default Screen (see chapter three of the COREDOC User Guide). Otherwise, the
application will display the COREDOC Main Menu screen.

Creating a Core Document

Go to the COREDOC Main Menu Bar, click the “File” menu. Select “New” to create a core document.
The application will display a list of available occupational series.

Use the scroll bars to navigate through the list of occupational series or type the first letter of the job title
after the “%” character in the locator block. Click the “FIND” button. When you have highlighted the
desired series, click “OK”.

The application will display the Core Document (CD) Type dialog box. This dialog box allows you to
create a standard or regular core document. Click the appropriate check box. Click the “OK” button.

The application automatically assigns a “TMP Number”. However, we recommend that you enter your
own eight character identifier for the core document. Click the “OK” button to accept this number. The
application will then display the Duty Listing Screen.

Review all the duties associated with the series. To select duties, click the check box located to the left of
the duty statement. The application will then display the Duty Classification Levels Screen.

Click the Position Title to the side of each grade level. The application will display a short description of
the work associated with that grade level. To display the duty statement, click the “ Statement” button.
Review statement, click “Return”. To select a grade level, click the check box. The application will return
you to the Duty Listing Screen.

Repeat steps 5 and 6 to select additional duties. After you have selected your last duty statement, click
the “Continue” button.

The application will display a Duty List Opportunity screen. Click the “Prev” button to select additional
duties. Click the “Save and Quit” button to exit COREDOC. Click “Continue” to display the
Supplementary Requirements Screen.

Review the additional requirements statements associated with this series. To select a statement, click the
check box located on the left hand side of the statement. Click the “OK” button to save your selection(s).
Click “Continue” to proceed to the Percentage of Time screen.
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10.

11.

12.

13.

The application will automatically assign a percentage to each duty. You may enter a new percentage for
each duty statement. Click the “Continue” button.

The application will display the Knowledges, Skills, and Abilities (KSAs) for the position based on the
duties and grade levels you selected. Click the appropriate checkboxes. Click the “Continue” button.

The application will display the Core Document Summary screen. Click the “Continue” button.

The application will display the Goals and Purpose screen. The organization you entered in the System
Defaults Screen is automatically entered on your core document. Go to the “Organizational Goals” block
and select “Standard Goals”. Click the “Continue” button. Note: Air Force users should go to Step
15.

. The application will display the Performance Management Plan Screen. Click “ Duties” button to view the

duty statements that you previously selected. Click the “Continue” button.

. The application will then display the Core Document Summary screen. Go to the “Edit” Menu. Review

the options. Select “Exit” to return to the Core Document Main Menu screen.

Viewing and Printing a Core Document

Go to the COREDOC Main Menu Bar, click the “File” menu. Select “Open” to view a list of previous
created core documents. Use the scroll bar or the “Find” option to highlight a core document. Click the
“OK” button.

Click the “Reports” menu. Select the “Core Document” option. The application will display the Reports
Destination screen. Select “Previewer” and then click the “OK” button.

The application will display the Previewer screen. Use the scroll bars to view the core document.

Go to the “File” Menu within the Previewer screen. Select the “Choose Printer” option. Using your mouse,
highlight the desired printer from a list of pre-defined printers. Click the “OK” button.

Click the “OK” button located at the bottom of the Print Job dialog box. The application will again display
the Previewer screen. Click the “Print” button. After the print job is finished, click the “Close” button.

Logging off COREDOC

Go to the Coredoc Main Menu Screen. Click the “File” menu. Click the “EXIT” button.

The application will display the message, “Do you wish to exit the Core Document System”. Click “Yes”.
The application will then return you to the PPl Application Menu.

Click the “EXIT” button to return to the Program Manager screen.
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Initiating a COREDOC Session

Open COREDOC by clicking the Integrated Personnel Process Improvement (PPI) Suite icon from the
Program Manager screen.

Type your Username and press the [Tab] key. Enter your password. Click the “CONNECT” command
button. The application will display the PPl Application Menu screen.

Click the “COREDOC” option. If this is the first time accessing the COREDOC system, the application will

display the System Default Screen (see chapter three of the COREDOC User Guide). Otherwise, the
COREDOC Main Menu screen is displayed.

Creating a Core Document

Go to the COREDOC Main Menu Bar, click the “File” menu. Select “New” to create a core document.
The application will display a list of available occupational series.

Use the scroll bars to navigate through the list of occupational series or type the first letter of the job title
after the “%” character in the locator block. Click the “FIND” button. When you have highlighted the
desired series, click “OK”.

The application will display the work situation for the series you selected. Click the “information” button
to view additional information and any special instructions concerning the series. Click the “Continue”
button.

The application automatically assigns a “TMP Number”. However, we recommend that you enter your
own eight character identifier for your core document. Click the “OK” button to accept this number. The
application will then display the Duty Listing Screen.

Review all the duties associated with the series. To select duties, click the check box located to the left of
the duty statement. The application will then display the Duty Classification Levels Screen.

Click the Position Title to the side of each grade level. The application will display a short description of
the work associated with that grade level. To display the duty statement, click the “ Statement” button.
Review Statement, click “Return”. To select a grade level, click the check box. The application will return
you to the Duty Listing Screen.

Repeat steps 5 and 6 to select additional duties. After you have selected your last duty statement, click
the “Continue” button.

The application will display a Duty List Opportunity screen. Click the “Prev” button to select additional
duties. Click the “New Series” to select another series to mix with the series previously selected. Click
the “Save and Quit” button to exit COREDOC. Click the “Continue” to display the Supplementary
Requirements Screen.

Review the additional requirements statements associated with this series. To select a statement, click the
check box located on the left hand side of the statement. The application will then take you to the
Supplementary Selection screen. To select an item, click on the check box for the appropriate selection

COREDOC Quick Help for Managers (Cont.
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The application will then return you to the Supplementary List screen to make further selections.. Click the
“OK” button to save your selection(s). Click “Continue” to proceed to the Percentage of Time screen.

10. The application will automatically assign a percentage to each duty. You may enter a new
percentage for each duty statement. Click the “Continue” button.

11. The application will display the Knowledges, Skills, and Abilities (KSAs) for the position based on the
duties and grade levels you selected. To select, click the appropriate checkboxes. Click the
“Continue” button.

12. The application will display the Core Document Summary screen. Click the “Continue” button.

13. The application will display the Goals and Purpose screen. The organization you entered in the
System Defaults Screen is automatically entered on your core document. Go to the “Organizational Goals”
block and select “Standard Goals”. Click the “Continue” button. Note: Air Force users should go to
Step 15.

14. The application will display the Performance Management Plan screen. Click “Duties” button to view
the duty statement that you previously selected. Click the “Continue” button.

15. The application will then display the Core Document Summary screen. Go to the “Edit” Menu.
Review the options. Select “Exit” to return to the Core Document Main Menu screen.

Viewing and Printing a Core Document

Go to the COREDOC Main Menu Bar, click the “File” menu. Select “Open” to view a list of previously
created core documents. Use the scroll bar or the “Find” option to highlight a core document. Click “OK”.

Click the “Reports” menu. Select the “Core Document” option. The application will display the Reports
Destination screen. Select “Previewer”. Click the “OK” button.

The application will display the Previewer screen. Use the scroll bars to view the core document.

Go to the “File” Menu within the Previewer screen. Select the “Choose Printer” option. Using your mouse,
highlight the desired printer from the list of pre-defined printers. Click the “OK” button.

Click the “OK” button located at the bottom of the Print Job dialog box. The application will again display
the Previewer screen. Click the “Print” button. After the print job is finished, click the “Close” button.

Logging off COREDOC

Go to the Coredoc Main Menu Screen. Click the “File” menu. Click the “EXIT” button.

The application will display the message, “Do you wish to exit the Core Document System”. Click “Yes”.
The application will then return you to the PPI Application Menu.

Click the “EXIT” button to return to the Program Manager screen.
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